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1 Introduction 
The F900 software is used to control the fluorescent spectrometers manufactured by Edinburgh Instruments 
Ltd and, in addition, acquire, process and analyse the data produced by them. The instruments are the FS920 
Steady State Fluorimeter, the FL920 Fluorescence Lifetime Spectrometer, and the FLS920 Combined Steady 
State and Lifetime Spectrometer. An overview of steady-state and lifetime options will now be given, together 
with descriptions of the optional attachments for them. 
 
 

1.1 Steady State Fluorimeter (FS920) 

The FS920 steady state fluorimeter has a modular design. The key components are the xenon lamp, excitation 
monochromator, sample chamber, emission monochromator, and these individual components are joined 
together to give a robust opto-mechanical assembly mounted to a platform. Figure 1.1 shows the FS920, 
comprising xenon lamp (Xe900), excitation and emission monochromators (M300), sample chamber (UC920) 
with integrated control electronics (CD920/CD930), and detector (S900). 

The Xenon lamp produces a broad spectrum of high intensity radiation through the UV-Vis-IR range. The arc 
from this lamp is imaged onto the entrance slit of the excitation monochromator, which selects a specific 
excitation wavelength with a specific bandwidth (Figure 1.2). 
 
 

 

Figure 1.1: FS920 steady-state fluorimeter configuration. 
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Figure 1.2: Schematic of the FS920 steady-state spectrometer configuration. 

 
 
The radiation of a specific bandwidth and spectral resolution is passed from the excitation monochromator 
through a beam-splitter (where a small percentage is reflected onto a reference detector), an iris (so that the 
intensity can be controlled) and is then focused into the sample. A portion of any luminescence from the 
sample is collected by a lens system and focused onto the emission monochromator. The emission 
monochromator selects a wavelength and spectral bandwidth of this emission and the light is passed into a 
photomultiplier tube (PMT). 
 
The control electronics are located beneath the sample chamber. Only the xenon lamp power supply and an 
optional detector cooler power supply are separate from the FS920 spectrometer assembly. This set-up 
maintains the modularity and flexibility of the opto-mechanical design while minimising the number of external 
cables. The communication to a separate, dedicated computer is made via an RS232 port. All signal 
processing electronics are located in the computer. Data acquisition is achieved via a photon counting scalar 
card (PCS900) plugged into a PCI slot of the computer. 
 
 

1.2 Fluorescence Lifetime Spectrometer (FL920) 
The Fluorescence Lifetime Spectrometer is based on the technique of Time Correlated Single Photon 
Counting (TCSPC). A typical configuration (Figure 1.3) would include a nanosecond flashlamp (connected to 
the second port of the excitation monochromator) and the TCSPC data acquisition card, TCC900, which is 
installed in a PCI slot in the computer. Alternatively, pulsed LED’s and pulsed diode lasers can be used as light 
sources. The light path follows the same route as the FS920 fluorimeter. 
 
Both the FS9290 and the FL920 instruments can be configured as a phosphorescence lifetime spectrometer 
by using a microsecond lamp, coupled to the first entrance port of the excitation monochromator (also shown 
in Figure 1.3). The PCS900 computer plug-in card can be set up to operate in multichannel scaling (MCS) 
mode, a mode acquiring single photons in a time resolved manner. 
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Figure 1.3: FL920 fluorescence lifetime spectrometer configuration. 

 

 

1.3 Additional Computer Controlled Options 
Along with the standard features of the above instruments, a number of optional components and 
configurations can be added and controlled by the F900 software. 
 
Light Sources: Additional light sources can be coupled either directly to the sample chamber or onto the 

entrance of the excitation monochromator. The F900 software can then control the excitation 
monochromator, allowing computer control of the excitation source by means of up to two computer 
controlled swing mirrors. Optional light sources include the nanosecond flashlamp, pulsed LED’s or 
diode lasers, pulsed microsecond flashlamp or high power Q-switched lasers. 

 
Detectors: The monochromators incorporated into the FS920 can be fitted with up to two exit slits. A 

computer controlled swing mirror enables the user to select the emission port of choice. As such, 
additional detectors may be fitted to the emission monochromator to increase the detection spectral 
range. There are currently PMT detectors available that span the wavelength range 185 – 870 nm. In 
addition germanium PIN diode detectors can be used with a responsivity from 800 – 1700 nm or 
InGaAs PIN photodiodes with responsivity from 900 –2500 nm. Up to 3 diffraction gratings can be 
mounted on the computer controlled grating turret in the monochromator. The grating is selected to 
optimise the performance of the monochromator over the wavelength of responsivity of the selected 
detector. In addition, the PCS900 photon counting card has five signal input channels, each input 
selected from the F900 software. 

 
Automated Polarisers: High throughput UV transmitting Glan Thompson polarising prisms, with a 14 mm 

diameter clear aperture, can be provided to allow anisotropy and other polarisation effects to be 
studied. The prisms are held in computer controlled mounts allowing user defined or preset 
polarisation angles. 

 
Cryostat Systems: Oxford Instruments liquid nitrogen or helium cryostats with ITC controllers are used when 

low temperature measurements are required. The F900 software communicates fully with the cryostat 
controller allowing temperature profiles and temperature dependant spectral maps to be acquired 
under computer control. 

 
Sample Positioner: A three position sample holder can be coupled to the sample chamber. This can be 

controlled by the F900 software and allows different set-ups to be configured for each sample position. 
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T-Geometry: The system can be configured as a T-Geometry with two emission arms allowing two 

monochromators and up to four detectors to be permanently fitted to the system. 
 
 

1.4 F900 Software Overview 
The F900 software allows the user to control almost all aspects of the hardware, to set-up measurements, to 
make measurements, to perform data analysis and process this data. It is a Windows-based operating system 
and the format of the software is such that functional control can be either from the main menu which can be 
pulled down to open sub menus or through the shortcut toolbar (Figure 4.1) which opens the sub menus. Each 
of the highlighted sub menus can open dialog boxes to allow the user to enter data. Sub menus are not active 
(not highlighted) if the options contained in those sub-menus are not applicable, e.g. the corresponding 
hardware is not present. Another function of the software is the status bar; this is located at the bottom of the 
F900 window and displays information about the current setup relevant to the measurement being carried out. 
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2 Software Installation 
The F900 software is the operating software for the FL920, FS920 and the FLS920 spectrometers. The 
software is compatible with Windows 2000 and it is supplied on two CD-ROMs. The first one contains all the 
system software and should start automatically when the disk is inserted into the drive. The second CD-ROM 
contains optional software that has been individually configured for the specific system. 
 
The software has a protection device that needs to be installed in  parallel port LPT1 before starting the 
software. 
 
 

2.1 Installation of System Disk 
To install the F900 software, please follow these instructions: 

 
1. Place the F900 installation disk into the CD-ROM drive of the computer. The installation 

programme should start automatically. If it does not then follow the following procedure: 
 

a. On the Windows Taskbar press ‘Start’ then ‘Run’. In this dialog box press ‘Browse’ and 
select the CD-ROM drive. 

 
b. In the root directory, select the file ‘Setup.exe’. Press ‘Open’ to return to the ‘Run’ dialog box 

and then press ‘OK’. 
 
2.  Follow the instructions to install the F900 software package. 
 
3. Once the installation has completed, the auxiliary disk for the F900 software can be run.  

 
 

2.2 Installation of Auxiliary Disk 
To install the utilities in the Auxiliary Disk, Please follow the following procedure: 

 
1. Place the F900 auxiliary disk into the CD-ROM drive of the computer. The installation programme 

should start automatically. If it does not then follow the following procedure: 
 

a. On the Windows Taskbar press ‘Start’ then ‘Run’. In this dialog box press ‘Browse’ and 
select the CD-ROM drive. 

 
b. In the root directory, select the file ‘Setup.exe’. Press ‘Open’ to return to the ‘Run’ dialog box 

and then press ‘OK’. 
 
2. In the Select Features menu, choose the items to be installed. The options are: 
 

a. Install hardware configuration: This will load an initial hardware configuration, tailored for 
the specific system, into Windows registry. Full details of hardware configuration are given in 
Chapter 3 of this manual. 

 
b. Install correction files: Checking this option will copy correction files for the 

instrumentation installed with the system hardware. 
 
c. Install manuals: Selection of this option will install the manuals relevant to the particular 

system as portable document format (pdf) files in the EI directory. 
 
d. Install EI wallpaper: Acceptance of this option will install a utility that displays contact 

information for Edinburgh Instruments. 
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3 Hardware Configuration 
Prior to running a spectrometer with the L900 software, the availability and setting of the spectrometer 
components have to be made known to the software. This is done by calling the Hardware Configuration 
utility, which loads the spectrometer settings into system Registry for use by the F900 software. This utility can 
be called from two locations, which are: 
 

a) The Cd920Test programme that is used in initial configuration of the system and for component 
testing. This route is only normally used when the system is being initially configured. 

 
b) The F900 software itself. The hardware configuration utility can be called by selecting Hardware 

Configuration from the Options menu. This route is normally used when the hardware setup is to be 
modified for a different type of measurement. 

 
 
 

 

Figure 3.1: Opening screen for the Hardware Configuration utility. 
 
 
When opened, the utility will look similar to the one shown in Figure 3.1. The major components of this screen 
are the System Type, which specifies whether the spectrometer is configured in an L Geometry or a T 
Geometry; a set of tabbed items that are groupings for the hardware components (these will be described in 
more detail below); notification of the root directory for the F900 software; an OK button to accept hardware 
changes that have been made and to write them to system registry; a Cancel button to abandon any changes 
and to exit the utility. The groupings on the tabbed items will now be described in more detail. 
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3.1 CD Controller 
 

 

Figure 3.2: Controller tab. 

 

The tab for the CD920/CD930 controller is shown in Figure 3.2. There are two settings in this tab and these 
are: 
 
Present: Checking this box indicates to the software that the controller is present in the system. This is 
normally true and it is only for unusual geometries, such as the TL900 lifetime spectrometer, where there is no 
controller present. 
 
COM Port: This gives the user the choice of RS232 port on the host computer that the controller should be 
connected . This is normally COM1. 
 
 
 

3.2 Detectors 
The Detectors tab is used to configure the nature of the detectors used to monitor the light output from the 
Excitation monochromator and to record the light emanating from the emission monochromator(s). An 
example of this tab is shown in Figure 3.3. It is possible for an emission arm to have more than one detector 
fitted. This is because the monochromator has two output ports, selectable by a movable mirror. 
 
To inform the software of the presence of a detector, ensure that the appropriate check box has been ticked. 
For the Reference Detector this is the Present check box and for the emission arm detectors these are the 
Detector 1 and Detector 2 check boxes.  
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Figure 3.3: Detectors tab. 

 

To enter the details for the Reference Detector press the Details button in the Excitation Reference Detector 
group box. This will open a dialog box similar to the one shown in Figure 3.4. The entries that can be made for 
this box are: 
 

Description: This is a user-chosen name for the reference detector. 
Connected to: This is the data acquisition card that is connected to the detector output. The options 

are the PCS-900 card and the TCC-900 card. 
Chan: This is the channel port on the card that is connected to the reference detector. 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 

 

Figure 3.4: Example of settings for an excitation reference detector. 

 

To enter the details for an Emission Detector press the Details button corresponding to chosen detector’s 
check box. This will open a dialog box similar to the one shown in Figure 3.5. The entries that can be made for 
this box are: 
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Description: This is a user-chosen name for the reference detector. 
Mono Port: This is the output port of the monochromator to which the detector is attached. The 

options are Port A and Port B.  
Connected to: This is the data acquisition card that is connected to the detector output. The options 

are the PCS-900 card and the TCC-900 card. 
Chan: This is the channel port on the card that is connected to the reference detector. 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 

 

Figure 3.5: Example of settings for an emission detector. 
 
 
 

3.3 Lamps 

 

Figure 3.6: Lamps tab. 

 

The Lamps tab is used to configure the light sources that are used to illuminate experimental samples. These 
lamps are normally fitted to the input ports of the excitation monochromator. An external swing mirror can be 
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fitted to one of these ports so it is possible to have three alternative light sources fitted to the spectrometer 
system. If a light source is fitted then the corresponding check box should be ticked.  
 
 

 

Figure 3.7: Example of settings for a nanosecond flashlamp. 
 
To enter the details for a Nanosecond flashlamp press the Details button corresponding to the nanosecond 
flashlamp check box. This will open a dialog box similar to the one shown in Figure 3.7. The entries that can 
be made for this box are: 
 

Description: This is a user-chosen name for the reference detector. 
Mono Port: This is the output port of the monochromator to which the detector is attached. The 

options are Port A and Port B.  
Connected to: This is the data acquisition card that is connected to the detector output. The options 

are the PCS-900 card and the TCC-900 card. 
Chan: This is the channel port on the card that is connected to the reference detector. 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
 

 

Figure 3.8: Example of settings for a microsecond flashlamp. 
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To enter the details for a Microsecond flashlamp press the Details button corresponding to the microsecond 
flashlamp check box. This will open a dialog box similar to the one shown in Figure 3.7. The entries that can 
be made for this box are: 
 

Description: This is a user-chosen name for the reference detector. 
Mono Port: This is the output port of the monochromator to which the detector is attached. The 

options are Port A and Port B.  
TriggerDelay:   This is the delay between the trigger pulse to the acquisition card and the one to the 

flashlamp trigger pulse. 
Lamp Latency: This value is used to delay the time that the acquisition card starts measuring. It 

compensates for delays between a lamp (or laser) being triggered and its output being 
generated. 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
 

 

Figure 3.9: Example of settings for an external lamp. 

 

To enter the details for a steady-state (Xenon) flashlamp press the Details button corresponding to the steady-
state flashlamp check box. This will open a dialog box similar to the one shown in Figure 3.9. The entries that 
can be made for this box are: 
 

Description: This is a user-chosen name for the reference detector. 
Mono Port: This is the output port of the monochromator to which the detector is attached. The 

options are Port A and Port B.  
Shutter Device: This is the device number used for an external shutter for the steady-state lamp. 
 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
 
 
 
 
 
 
 
 
 

3.4 Lifetime Cards 
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Figure 3.10: Lifetime cards tab. 

 

The Lifetime Cards tab displays the availability of the cards that are used for lifetime measurements and  if 
there is more than one, allows the user to choose the card to be used. 
 
 

3.5 Miscellaneous 

 

Figure 3.11: Miscellaneous tab. 

 

The Miscellaneous tab is used for settings that do not belong naturally to any of the other tabs. The presence 
of these attachments is made known to the software by checking the appropriate Present box and detailed 
information for each item can be entered by clicking the corresponding Details button. 
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3.5.1 Multiple Sample Holder 

 

Figure 3.12: Example of sample holder settings. 
 

If a multiple sample holder has been installed, then its configuration can be entered on a form similar to the 
one shown in Figure 3.12. The High Level Info grouping refers to the sample holder positions and the Low 
Level Grouping refers to the stepper motor that positions the sample holder. Normally the multiple sample 
holder has three positions. The low-level settings are not normally changed in the field. Details of the settings 
are: 

Description: This value is entered by the user to put a name to the configuration setup. It is only for 
identification purposes and has no effect on system operation. 

 
Range Low: This is the lowest available position of the sample holder. 
Range High: This is the highest available position of the sample. 
Initial Position:  This is the position that the sample holder will initially move to when the software is 

started. 
Resolution: This is the increment that is added when the sample holder position is changed. Since the 

sample holder can only have an integral number of positions this value should always be set to 
1. 

 
The Low Level Info settings should not be altered from their factory settings, without exlicit instruction from 
the Edinburgh Instruments service department. The factory settings are: 
 

Step Multiplier: 9000 
Step Zero: 0 
Step Mode: Full 
Step Sequence: 2 Ph 
Step Freq: 0.99 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
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3.5.2 Oscilloscope 

 

Figure 3.13: Example of oscilloscope settings. 

 

If an oscilloscope has been installed with the system, then its configuration can be setup with the form shown 
in Figure 3.13. The details that can be entered are: 
 

Interface: This setting is used to select the communications interface between the oscilloscope and 
the computer. The currently available options are Ethernet and Serial (RS-232). If serial 
communications have been chosen, the Setup COM Port button should be pressed to select 
the communications values (details below). 

Scope Channel: This setting chooses the oscilloscope channel that data is to be acquired from. The 
options are channel 1 only, channel 2 only, or both channel 1 and channel 2. 

Scope Type: This is the type of oscilloscope that is attached to the system. The currently available 
options are the Tektronix TDS3012 and Tektronix TDS3052. 

Data Points: This is the number of data points that are to be acquired from the oscilloscope. The 
oscilloscope itself will transfer 10000 data points, but this can be reduced by data compression 
(averaging of neighbouring data points) to 5000 (1:2), 3333 (1:3), 2500 (1:4), 2000 (1:5),  1000 
(1:10), or 500 (1:20). Note that is the time scale on the oscilloscope is less than 200 ns/div 
then it will always transfer 10000 data points over a time range of 2 µs. 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
If serial communications are to be used, then the communications port settings have to be entered. This is 
done by pressing the Setup COM Port button. Please note that the settings entered here have to match those 
set in the oscilloscope. The options are: 
 

Port: This is the COM port on the computer that is to be used to communicate with the oscilloscope. 
The options are COM1 and COM2. since the CD920 controller is normally on port COM1, the 
oscilloscope is then on port COM2. 
Baud rate: This is the data transfer rate, and is normally set to 38400 baud. 
Data bits: This is the number of data bits sent per byte transferred and is normally set to 8. 
Stop bits: This is the number of stop bits used and is normally set to 1. 
Parity: This is the parity convention to be used and is normally set to None. 
Flow control: This is the flow control protocol; the value is normally set to Hardware. 
 

The OK button is used to accept the new values and to close the form. The Cancel button closes the form 
without accepting the changes. 
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Figure 3.14: Example of oscilloscope RS-232 settings. 

 

3.5.3 Cryostat 

If a cryostat has been attached to the system then pressing the corresponding Details button will open the 
form shown in Figure 3.15. The cryostat uses serial communications to interact with the F900 software. 
 

 

Figure 3.15: Example of cryostat settings. 

 

The settings details are: 
 

COM Port: This is the communications port on the computer that is used to talk to the cryostat. The 
options are COM1, COM2, COM3, COM4. If an oscilloscope has been attached to the system then 
this setting is normally COM3, otherwise it is normally COM2. 
Baud Rate: This is the data transfer rate between the computer and the cryostat and has to be set to 
the same value on both instruments. The normal setting is 9600 baud. 
Range Low: This value is the lower temperature limit of the sensor in Kelvin. 
Range High: This value is the upper limit of the sensor in Kelvin.  
 

A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
 
3.5.4 Iris 

If a computer-controlled Iris has been installed in the system, then the dialog shown in Figure 3.16 should be 
opened to set its values. The High Level Info grouping contains information on how wide the iris should be 
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opened. The Low Level Info grouping contains factory-set values for the stepper motor controlling the iris. 
The low-level settings are not normally changed in the field. Details of the settings are: 

Description: This value is entered by the user to put a name to the configuration setup. It is only for 
identification purposes and has no effect on system operation. 

 
Range Low: This is the lowest available opening for the iris (as a percentage). 
Range High: This is the highest available opening for the iris (as a percentage. 
Initial Position:  This is the opening (expressed as a percentage) that the iris will initially move to 

when the software is started opening for the iris. 
Resolution: This is the increment that is added when the iris opening is changed. The control of the 

iris is such that only integral values can be entered here. 
 
The Low Level Info settings should not be altered from their factory settings, without explicit instructions from 
the Edinburgh Instruments service department. The factory settings are: 
 

Step Multiplier: 1 
Step Zero: 0 
Step Mode: Half 
Step Sequence: 2 Ph 
Step Freq: 4 

 

 

Figure 3.16: Example of iris settings. 

 

 

3.6 Monochromator Tab 
The Monochromators tab (shown in Figure 3.17) contains information on the monochromators that have 
been attached to the system. In a standard configuration there is an Excitation monochromator to select the 
wavelength of the light entering the sample chamber and an Emission monochromator to select the 
wavelength of the light exiting the sample chamber. For T geometries there is a second Emission 
monochromator on the other output arm. For monochromators have more than one grating (three are possible 
for TM300 and TMS300 monochromators), it is possible to change the selection of grating without going into 
the details of the selected monochromator. 
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Figure 3.17: Monochromator tab. 
 
 
If the monochromator Details button is pressed, then the form shown in Figure 3.18 is displayed. This form 
has several sections, which are: 
 
Present: Whether the monochromator is present on the spectrometer system. 
 
Type: This is the type of the monochromator that is fitted. The options are TM300, TM300, M300, M100. For 
monochromators with computer-controlled slits (these may be labelled as TMS300 monochromators), select 
the TM300 and tick the Present box in the Controlled Slits grouping. 
 
Stepper Details: The details of the stepper motor controlling the monochromator grating(s). 
 
Gratings: The availability of the monochromator gratings is set here and the details for each grating can be 
displayed. 
 
Wavelength Increments: These are the incremental values that can be used to change the monochromator 
wavelength in the application software( F900); they are changeable by pressing the Details button. 
 
Ports: This grouping is used to set the configuration of the input ports for the Excitation monochromator or the 
output port for the Emission monochromator(s). 
 
Controlled Slits: If the monochromator has computer-controlled slits fitted, then clicking the Details button 
will allow their settings to be entered.  
 
The settings will now be discussed in greater detail. 
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Figure 3.18: Sample of detailed monochromator settings. 

 

3.6.1 Stepper Details 

 

Figure 3.19: Sample of monochromator micro-stepper settings. 

 

The details for the monochromator stepper motor details are shown in Figure 3.19. These values are normally 
factory-set and should not be changed without consulting Edinburgh Instruments’ service department. The 
factory-settings are: 
 

Step Period: 4 
Step Lower Limit: 0 
Step Upper Limit: 8500000 
Step Zero: 0 
µsteps per full step: 25 
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A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
 
 
3.6.2 Gratings 

The Gratings grouping allows the user to select what gratings are present. Note that if the monochromator is 
an M300 or an M100 then only one grating will be available. Pressing the Details box for a particular grating 
opens up the dialog box shown in Figure 3.20. 
 

 

Figure 3.20: Example of monochromator grating details. 
 
This dialog box allows the user to enter detailed settings for the selected grating as well as display information 
on the computer-controlled slits attached to the monochromator (if these are fitted). The information that can 
be entered is: 
 

Grating type: This drop-down box permits the user to enter the groove density (in grooves per mm) of 
the grating. The allowable values are 50, 75, 150, 300, 600, 840, 1200, 1800, 2400, 3600. 

Description: This edit box allows the user to enter a description of the grating. It usually contains the 
wavelength limits for the grating, although it does not have to. The user should be aware that 
this description is used in the software to describe the grating, so it is important to enter 
meaningful text here. 

Range Low: This is the lower bandwidth limit of the grating’s response function. 
Range High: This is the upper bandwidth limit of the grating’s response function. 
Resolution: This is the limiting resolution of the grating. 
Initial Position: This is the position of the grating when the F900 software is initialised. 
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If the monochromator has computer-controlled slits then the bandwidth limits, resolution, and linear dispersion 
for the selected grating are shown here. Should the settings for the slits be subsequently changed then these  
values will also change. 
 
The values are stored by pressing the OK button and abandoned by pressing the Cancel button. Pressing 
either of these buttons will close the dialog box. 
 
 
3.6.3 Wavelength Increments 

Pressing the Details button in the Wavelength Increments grouping opens the dialog box shown in Figure 
3.21. The step sizes for each step number can be entered, either directly, or by clicking the increment arrows, 
to change the value of a nominated step. It is normal practice to have the step sizes in order of increasing 
increments. 
  

 

Figure 3.21: Example of monochromator step size settings. 

 

A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 

 
3.6.4 Ports 

If there are mirrors on the entrance (excitation) or exit (emission) monochromators then these should be ticked 
in the appropriate check box in the Ports grouping. Checking Mirror 1 denotes that there is a mirror at the 
entice port and checking Mirror 2 indicates that there is a mirror at the output port. One a mirror has been 
indicated as being present, a drop-down box (Initial Position) becomes editable. This box is used to indicate 
to the F900 software what position the mirror should be in when the software is initialised. The alternatives are 
Port A and port B. 
 
3.6.5 Controlled Slits 

If the monochromator is fitted with computer-controlled slits than this check box should be ticked; otherwise it 
should be left unticked. Pressing the Details button will open the dialog box shown in Figure 3.22. This box 
allows the user to enter the limiting and initial values for the slits. The details are: 
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Range Low: This is the smallest slit gap that can be set in the F900 software. The smallest value that 
can be entered here corresponds to 1 step of the stepper motor, which with a resolution of 200 steps 
per mm, corresponds to 0.005 mm. 
Range High: This is the largest slit gap that can be set in the F900 software. This value will depend on 
the hardware construction of the slit device; currently this is 15 mm. 
Initial Position: This is the slit gap that is set when the F900 software is initialised. 
Resolution: This edit box is used to enter the number of motor steps required to change the slit 
separation by 1 mm. With existing hardware, this value is 200 steps per mm. 

 

 

Figure 3.22: Example of motorised slit settings. 

 

The values are stored by pressing the OK button and abandoned by pressing the Cancel button. Pressing 
either of these buttons will close the dialog box. If the Stepper Details button is pressed then the dialog box 
shown in Figure 3.23 is shown. 

 

 

Figure 3.23: Example of motorised slit stepper motor details. 

 

This box contains details of the stepper motor settings for the slit device. These values should not normally be 
changed except by guidance from Edinburgh Instruments service department. The default values for the slit 
stepper motor are: 
 

Step Period: 1.95 
Step Zero: 1 
Step Multiplier: 1 
Step Mode: Full 
Step Sequence: 2 Ph 

 
A set of default values can be loaded by pressing the Default button. The values are stored by pressing the 
OK button and abandoned by pressing the Cancel button. Pressing either of these buttons will close the dialog 
box. 
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3.7 Polarisers 
The Polarisers tab is shown in Figure 3.24. If polarisers have been fitted to the system then the appropriate 
check boxes should be ticked. The details for a particular polariser can be displayed by pressing the 
appropriate Details button. This will open the dialog box shown in Figure 3.25. 
 
 

 

Figure 3.24: Polarisers tab. 

 

The High Level Info grouping contains information on the angles that the polariser should be set. The Low 
Level Info grouping contains factory-set values for the stepper motor controlling polariser. The low-level 
settings are not normally changed in the field. Details of the settings are: 

Description: This value is entered by the user to put a name to the configuration setup. It is only for 
identification purposes and has no effect on system operation. 

 
Range Low: This is the smallest angle that the polariser can be set in the F900 software (expressed in 

degrees). 
Range High: This is the largest angle that the polariser can be set in the F900 software (as a 

percentage. 
Initial Position:  This is the initial angle that the polariser will initially move to when the F900 software 

is initialised. 
Resolution: This is the change in value that is added when the polariser angle is incremented in the 

F900 software..  
 
The Low Level Info settings should not be altered from their factory settings, without explicit instructions from 
the Edinburgh Instruments service department. The factory settings are: 
 

Step Multiplier: not used. 
Step Zero: 0 
Step Mode: Full 
Step Sequence: Wave 
Step Freq: 1.60 
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Figure 3.25: Example of polariser configuration settings. 
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4 Software Features 
This chapter of the manual describes how to start the  F900 software, and how to use the features that are 
normally visible whenever the software is running. It is assumed that the software has already been installed in  
the folder ‘C:\Program Files\EI\F900’. 
 
With all components of the spectrometer switched on e.g. the Xe900 Xenon lamp and CD920/CD930 controller 
(switch on the front of the sample chamber); turn on the computer and double-click the F900 icon shown on 
the desktop. Alternately the F900 program can be reached from going into the ‘EI’ folder within program files in 
either windows explorer or in the start menu. Starting the software causes it to detect and initialise all the 
system components that had been selected in Hardware Configuration. 
 
 

Important: The software has a protection device (dongle) that needs to be 
installed in the parallel port LPT1 before starting the software. 

 
 
 

4.1 Main Menu and Shortcut Toolbar 
 

 

Figure 4.1: Main menu and EI toolbar. 
 
 
The main menu that is displayed at the start up of the F900 software, prior to any data acquisition, is shown in 
Figure 4.1. This menu comprises drop-down menus for operation of the F900 software and optional shortcut 
icons for the most commonly used operations. The shortcut toolbar can be enabled/disabled by clicking 
View/Tool bar.  The submenu options will be described in the following sections. 
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The shortcut keys in the toolbar are grouped. The first group of three keys is important for data acquisition. 
These are the shortcut keys most often used when the user acquires data. The second group of five shortcut 
keys provide direct access to standard Windows file handling (Open, Save), file import and export options and 
printing facilities. The remainder of the shortcut toolbar are primarily graphics options and data windows 
options. The functions of the shortcuts are now described. 
 
 
 

 

View Signal Rate: Opens the Signal Rate dialog box. This box is the primary location 
for setting the monochromator wavelengths, slit apertures, polariser settings, iris 
settings, detector selection and light source selection. This box is also used to display 
count rates. 
 

 

New Spectral: Opens a menu that allows the user to select which type of spectral 
measurement to be performed.   
 

 

New Lifetime: Opens a menu that allows the user to select which type of lifetime 
measurement to be performed.   
 

 

 

Open: Enables the user to gain access to the file management system on the PC. 
 
 

 

Save: Enables the user to save measurement data as a file to a specified place in the 
file manager. 
 

 

Import GEM: Opens a menu to enable the user to import a GEM file. GEM is the data 
format that was used in spectrometers prior to 1995. 
 

 

Export ASCII: Opens a menu that enables the user to export acquired data in an 
ASCII format. 
 

 

Print: If a printer is connected directly to your PC, or the PC is networked giving you 
access to a PC, the button showing a printer symbol enables the user to print a 
specified measurement container. 

 
Once data has been acquired, it can be viewed in four different ways: 2D, 3D, text, contour. The data plot view 
buttons enable the user to change the viewing format of data that has been acquired. 

 

 

View As 2D Plot: This option displays the active graph as a two dimensional (2D) 
plot. 
 

 

View As 3D Plot: This option displays the active graph as a three dimensional (3D) 
plot. This option is only available for map-type plots. 
 
 

 

View As Text: This option displays the active graph as text. 
 
 

 

View As Contour Plot: This option displays the active graph as a contour plot. This 
option is only available for map-type plots. 
 
 

 

 

Plot options: This button opens a menu that permits the user to change the plot 
options for the active graph. 
 

 
The active measurement window can be modified while data is being acquired. The measurement plot can 
also be altered once the data has been acquired using the following options on the toolbar. 
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Zoom in: Pressing this button allows the user to zoom into an area of a scan of 
particular interest by drawing a rectangle around the chosen area. 
 

 

Zoom out: Pressing this button causes the whole graph to be displayed on screen. 
 
 

 

Cursor on: Pressing this button toggles the visibility of the cursor. The cursor appears 
as a pair of orthogonal crosshairs, with their intersection being displayed on the plot. 
 

 

Grids on: Pressing this button toggles the visibility of a grid connecting the major tick 
marks on the horizontal and vertical axes. 
 

 

Peaks on:  Pressing this button toggles the visibility of the values of the plot maxima 
and minima. The conditions for setting the peak search criteria can be found in the 
Data menu 
 

 

Normalisation:  Pressing this button toggles the normalisation the x and y graphs on 
the contour plot view. 
 

 
 

 

Properties:   Clicking this box allows the user to view the instrument and other 
settings for a scan. Some of these values may be edited.  
 

 
 

 

Join visible: Pressing this button joins all the visible, non-minimised plots into a single 
graph. This option is only available in 2D view and will only join plots of the same type 
as the currently active plot. 
 

 

Split: Pressing this button will separate the plots in the currently active graph into 
separate graphs, each containing a single plot. Only available in 2D view 
 
 

 

Extract:  Pressing this button will open a dialog box that invites the user to extract a 
single plot from the currently selected graph. 
 

 
 

 

Logarithmic scale: Pressing this button will display the y-axis as a logarithmic scale 
and will de-select the linear scale button. This option will only work if all the data 
points have positive y values.  
 

 

Linear scale: Pressing this button will display the y-axis as a linear scale and will de-
select the logarithmic scale button. 
 

 
 

 

Abort: Pressing this button stops any measurement mid-scan. A dialog box first 
appears asking for confirmation of the measurement termination. 
 

 
 
 
 
 

4.2 Status Bar 
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The status bar gives the user an indication of the current mechanical settings of the spectrometer. The status 
bar can be enabled/disabled by clicking View/Status Bar, its layout, for a standard FS920 system, when the 
software is loaded, is shown in Figure 4.2. 
 
 

 

Figure 4.2: Status Bar of Standard Spectrometer at Start Up 
 
 
 
Figure 4.2 shows the wavelength settings of the each monochromator (excitation and emission) and which 
sample is currently in place (this will always be ‘1’ unless a sample positioner is used, see section 1.2.5). 
 
The information displayed on the status bar alters depending on what the spectrometer is currently 
undertaking. The bottom left area of the status bar contains information on what process the spectrometer is 
carrying out at that time. Figure 4.3 shows the status bar as the spectrometer is setting up, before undertaking 
a spectral measurement. Figure 4.4 shows a status bar while a spectral measurement is being undertaken. 
 
 
 

Figure 4.3: Status Bar as Spectrometer is Setup for Measurement 
 

 

Figure 4.4: Status Bar During Spectral Measurement 
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5 Acquiring Spectral Data 
 

5.1 Setup Menu: Signal Rate 
The signal rate dialog box (Figure 5.1) is the primary instrumentation setup tool for the F900 software. It allows 
the signal from the sample under investigation to be optimised before a measurement is performed. The signal 
rate screen should be used before undertaking any measurements to adjust the following parameters: 
 

• Iris (light levels) 
• Wavelength of excitation and emission monochromators. 
• Bandwidth of monochromator slits (if computer-controlled slits fitted). 
• Polarisation directions (if applicable). 
• Excitation source. 
• Sample position. 
• Detector. 

 
 The signal rate screen can also be accessed via the Signal Rate icon on the toolbar. 
 
 

 

Figure 5.1: Signal rate dialog box 
 

5.1.1 Dialog Box Settings and Terms 

The excitation and emission wavelengths can be set by using the up and down arrows beside the 
corresponding wavelength edit box. The wavelength increment for each arrow press is determined by the step 
value, which can beset in the drop-down box adjacent to the wavelength edit box. Alternately, the parameter 
value can be changed using the keyboard to enter a revised value. Clicking Apply or pressing the Return key 
on the keyboard then updates the hardware.  
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The iris setting can be altered by using the arrows beside the iris setting box. The iris controls the intensity of 
radiation incident on the sample and is located in the sample chamber just before the reference detector 
(Figure 1.2). The iris is computer controlled with a stepper motor. The value in the iris box is an integer relating 
to how much light it lets through. ‘100’ is the maximum setting and corresponds to the iris fully open. ‘1’ is the 
lowest setting. 
 
If optional polarisers are fitted, the polarisation of the excitation illumination can be set by first moving the 
excitation polariser to the “in” position (into the beam path); clicking the Ex Polariser check box and then 
choosing the required angle in the corresponding drop-down box.  
 
If there is more than one light source connected to the spectrometer, the radio switches beside the names of 
the sources can be used to toggle between them. Correspondingly, if more than one detector is present, the 
desired detector can be selected from the drop-down box. 
 
Signal rate dialog boxes show real time readings from the both the reference detector and the emission 
detector. The reference detector rate can be displayed by ticking the Display Ref Signal  check box. Ref 
refers to the signal measured on the reference detector; Em1 refers to the signal measured on the detector 
connected to the emission monochromator. If a T-Geometry configuration is present, Em2 refers to the signal 
measured by the detector connected to the second emission arm. The signal rates are displayed in photon 
counts per second (cps) and are updated every second. The values are achieved by measuring the detector 
output for one tenth of a second and multiplying that value by 10. Below the value for the number of counts per 
second at each detector, there is a rate bar showing the counts with an automatic scaling function. The 
maximum value of the particular scale is shown to the top right of the rate bar. Although the detector outputs 
are annotated as cps, this rate is only the actual number of photons counted when digital detectors are used. 
For analogue detectors (such as an InGaAs detector or the silicon photodiode used as the reference detector), 
the rate displayed represents a relative irradiative intensity (on an arbitrary scale) measured by the detector. 
 
A temperature probe is fitted to the water cooled sample holder and therefore gives the actual temperature of 
the sample. The temperature is measured when the signal rate screen is first opened and this measured value 
is displayed. The Auto Update check box facilitates continuous temperature monitoring. When the water 
cooled sample holder temperature probe is used, the temperature is given in degrees Centigrade (oC), 
however if an optional cryostat system is fitted, the temperature in the cryostat is displayed in Kelvins (K)  
 
If the optional Sample Positioner is fitted there will be two more tabs present in addition to Sample 1. These 
are called Sample 2 and Sample 3. Each of these tabs contain the same information as Sample 1 but the 
settings are ‘remembered’ so the values for wavelength, polarisation, source, detector and iris can be set up 
for different samples. 
 
 
5.1.2 Using the Signal Rate Screen 

The main use of the signal rate dialog box is to set up the spectrometer before making a measurement. If the 
peak excitation and emission wavelengths are known, the monochromators can be set to those wavelengths 
and then the slits and iris adjusted to set up a bandwidth with sufficient counts to obtain useful spectra. If the 
peak wavelengths of excitation and emission are not known, the arrows beside the wavelengths can be used 
to scan through the wavelengths of excitation and emission until a maximum is established. The slits and iris 
can then be adjusted. Because of an inherent attribute of monochromators with motorised gratings called 
backlash, for increased accuracy it is best to approach the desired wavelength from the lower wavelength 
range. 
 
 

5.2 Scan measurements 
The spectral acquisition drop-down menu can be reached through the New Spectral Measurement option in 
the file menu, or by clicking the Spectral Measurement icon on the toolbar. 
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5.2.1 Emission Scan 

To perform an emission scan, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Emission Scan. The emission scan dialog box then appears 
(Figure 5.2). Although it is normal practice to use the Signal Rate screen to set up the instrumentation prior to 
commencing a measurement, some parameters can also be set in the scan setup screens, as will be seen. 
 
 

 

Figure 5.2: Emission scan dialog box. 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked.  

If an optional T-Geometry system is being used, Measurement Mode radio buttons are present. If L1 is 
selected, Emission channel 1 will be used (i.e. data will be acquired from the detector set up to be used on 
emission channel 1). If L2 is selected, Emission channel 2 will be used (i.e. data will be acquired from the 
detector set up to be used on emission channel 2). If T is selected, data will be acquired from emission 
channels 1 and 2 sequentially. Using a T measurement mode a wavelength offset can be applied between 
emission channels 1 and 2. The offset is set on the emission 2 tab (Figure 5.6). 

On the General tab select what correction, if any, is to be applied to the data. The correction options are: 
 

Ex Correction Value: This setting corrects for the excitation profile of the spectrometer. 
Em1 Correction File Data: This setting corrects for the spectral response of the emission 
monochromator and detector. 
Measure Simultaneously: Checking this setting will mean that the excitation light intensity is measured 
by the reference detector simultaneously with the emission detector. This option takes account of 
variations in light source intensity with time as well as spectral variation. Simultaneously measuring the 
reference detector is quite often a more accurate option, since if the monochromator slit sizes are 
different from the size they were when the excitation correction file was made, the spectral resolution of 
the monochromator will alter and therefore the lines of the Xenon spectra measured can be broadened 
or narrowed. 

 
The standard 450 W Xenon lamp used in the spectrometer is very stable, therefore if correction is required for 
emission scans, only the Em1 Correction File Data check box need be ticked. When any emission correction 
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is ticked, the software automatically selects the correct file depending on which detector is being used to 
acquire the data. 
 
On the Excitation tab (Figure 5.3), the values for the monochromator wavelength, slit bandwidth, lamp source 
and polariser that were set in the Signal Rate screen are displayed. If desired, the monochromator 
wavelength, lamp source and optional polarisers, if fitted, can be further modified. 
 
On the Emission tab(s) (Figure 5.4), the values for the slit bandwidth, detector and polariser that were set in 
the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified.  
 
In the Emission Scan Parameters box (Figure 5.2) enter the wavelength scanning range (Scan from/to); 
step size of scan (Step); dwell period at each wavelength (Dwell Time) and number of times the scan is to be 
repeated, and summed (Number of Scans). 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
 
 

 
Figure 5.3: Emission scan dialog box, excitation tab. 

 

 
Figure 5.4: Emission scan dialog box, emission tab. 
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Figure 5.5: Emission scan dialog box with a T-Geometry and optional 

sample positioner present. 
 

 

Figure 5.6: Emission scan, with emission 2 tab in T-Measurement 
mode 

 
 
5.2.2 Excitation Scan 

An excitation scan is normally used to obtain excitation spectra of a sample emitting at a specific wavelength. 
To perform an excitation scan, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Excitation Scan. The excitation scan dialog box then appears 
(Figure 5.7). Although it is normal practice to use the Signal Rate screen to set up the instrumentation prior to 
commencing a measurement, some parameters can also be set in the scan setup screens, as will be seen. 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked.  
 
If an optional T-Geometry system is being used, Measurement Mode radio buttons are present. If L1 is 
selected, Emission channel 1 will be used (i.e. data will be acquired from the detector set up to be used on 
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emission channel 1). If L2 is selected, Emission channel 2 will be used (i.e. data will be acquired from the 
detector set up to be used on emission channel 2). If T is selected, data will be acquired from emission 
channels 1 and 2 sequentially. Using a T measurement mode a wavelength offset can be applied between 
emission channels 1 and 2. The offset is set on the emission 2 tab. 
 
 

 

Figure 5.7: Excitation scan dialog box. 
 
 
On the General tab select what correction, if any, is to be applied to the data. The correction options are: 
 

Ex Correction Value: This setting corrects for the excitation profile of the spectrometer. 
Em1 Correction File Data: This setting corrects for the spectral response of the emission 
monochromator and detector. 
Measure Simultaneously: Checking this setting will mean that the excitation light intensity is measured 
by the reference detector simultaneously with the emission detector. This option takes account of 
variations in light source intensity with time as well as spectral variation. Simultaneously measuring the 
reference detector is quite often a more accurate option, since if the monochromator slit sizes are 
different from the size they were when the excitation correction file was made, the spectral resolution of 
the monochromator will alter and therefore the lines of the Xenon spectra measured can be broadened 
or narrowed. 

 
The standard 450 W Xenon lamp used in the spectrometer is very stable, therefore if correction is required for 
emission scans, only the Em1 Correction File Data check box need be ticked. When any emission correction 
is ticked, the software automatically selects the correct file depending on which detector is being used to 
acquire the data. 
 
On the Excitation tab (Figure 5.8), the values for the monochromator wavelength, slit bandwidth, lamp source 
and polariser that were set in the Signal Rate screen are displayed. If desired, the monochromator 
wavelength, lamp source and optional polarisers, if fitted, can be further modified. 
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Figure 5.8: Excitation scan dialog box, excitation tab. 
 
 
On the Emission tab(s) (Figure 5.9), the values for the slit bandwidth, detector and polariser that were set in 
the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified.  
 
 

 
Figure 5.9: Excitation scan dialog box, emission tab. 

 
In the Excitation Scan Parameters box (Figure 5.7) enter the wavelength scanning range (Scan from/to); 
step size of scan (Step); dwell period at each wavelength (Dwell Time) and number of times the scan is to be 
repeated, and summed (Number of Scans). 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
  
 
5.2.3 Synchronous Scan 

In synchronous scans, both excitation and emission monochromators are scanned synchronously with a 
preset offset. These scans can be used in order to separate and identify fluorescence components in mixtures. 
For low concentrations, each fraction of the molecules has a peak at a characteristic wavelength of the 
synchronous spectrum. 
 
To perform a synchronous scan, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Synchronous Scan. The excitation scan dialog box then 
appears  (Figure 5.10). Although it is normal practice to use the Signal Rate screen to set up the 
instrumentation prior to commencing a measurement, some parameters can also be set in the scan setup 
screens, as will be seen. 
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Figure 5.10: Synchronous scan dialog box. 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked.  
 
If an optional T-Geometry system is being used, Measurement Mode radio buttons are present. If L1 is 
selected, Emission channel 1 will be used (i.e. data will be acquired from the detector set up to be used on 
emission channel 1). If L2 is selected, Emission channel 2 will be used (i.e. data will be acquired from the 
detector set up to be used on emission channel 2). If T is selected, data will be acquired from emission 
channels 1 and 2 sequentially. Using a T measurement mode means that synchronous scans with two 
different offset wavelengths can be acquired at the same time. 
 
On the General tab select what correction, if any, is to be applied to the data. The correction options are: 
 

Ex Correction Value: This setting corrects for the excitation profile of the spectrometer. 
Em1 Correction File Data: This setting corrects for the spectral response of the emission 
monochromator and detector. 
Measure Simultaneously: Checking this setting will mean that the excitation light intensity is measured 
by the reference detector simultaneously with the emission detector. This option takes account of 
variations in light source intensity with time as well as spectral variation. Simultaneously measuring the 
reference detector is quite often a more accurate option, since if the monochromator slit sizes are 
different from the size they were when the excitation correction file was made, the spectral resolution of 
the monochromator will alter and therefore the lines of the Xenon spectra measured can be broadened 
or narrowed. 

 
The standard 450 W Xenon lamp used in the spectrometer is very stable, therefore if correction is required for 
emission scans, only the Em1 Correction File Data check box need be ticked. When any emission correction 
is ticked, the software automatically selects the correct file depending on which detector is being used to 
acquire the data. 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against their 
legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
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On the Excitation tab (Figure 5.11), the values for the monochromator wavelength, slit bandwidth, lamp 
source and polariser that were set in the Signal Rate screen are displayed. If desired, the monochromator 
wavelength, lamp source and optional polarisers, if fitted, can be further modified. 
 

 

Figure 5.11: Synchronous scan excitation tab. 
 
 
On the Emission tab(s) ) (Figure 5.12), the values for the slit bandwidth, detector and polariser that were set 
in the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified. 
 
 
 

 

Figure 5.12: Synchronous scan emission tab. 
 
 
In the Excitation Scan Parameters box (Figure 5.10) enter the wavelength scanning range (Scan from/to); 
step size of scan (Step); dwell period at each wavelength (Dwell Time) and number of times the scan is to be 
repeated, and summed (Number of Scans). 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
 
5.2.4 Kinetic Scan  

A kinetic scan monitors the luminescence intensity as a function of time subsequent to a single pulse of light 
from the Xe900 lamp. The lamp is shuttered on for a user-defined period of time and the decay in the 
luminescent intensity, subsequent to this excitation pulse, is monitored over a user-defined period of time. 
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To perform a kinetic scan, click the File main menu item, then select New Spectral measurement. This will 
display a drop-down. From this menu select Kinetic Scan. The excitation scan dialog box then appears  
(Figure 5.13).  
 
If the optional sample positioner is being used, the Sample radio buttons and a group of  Measure Samples 
check boxes are available. The Sample radio buttons allow scans to be set up differently for each sample to 
be measured. When the measurement is started, the samples measured are dependent on which Measure 
Samples check boxes have been ticked. 
 
 

 

Figure 5.13: Kinetic scan setup dialog box. 
 
 
The settings that can be made and viewed are: 
 
Scan Time: This is the duration of a scan. The value can be entered directly into the edit box or adjusted 
using the arrows at the side of the box. The time increment for each arrow click is the value of the Time 
Resolution edit box. Changes made with the arrows are implemented immediately, however directly-entered 
txt is only implemented when the Apply button has been pressed. 
 
Time Resolution: This is the time interval between consecutive data acquisitions.  This value can be entered 
directly into the edit box or adjusted using the arrowed buttons. The time increment for each arrow click is 0.1 
s. Changes made with the arrows are implemented immediately, however directly-entered text is only 
implemented when the Apply button has been pressed. 
 
No. of Data Points: The number of data points is calculated by dividing the  ScanTime by the Time 
Resolution. It is updated immediately if changes have been made with arrow buttons or, alternatively,  after 
the Apply button has been pressed. 
 
Use Shutter: Checking this box will enable the shutter in front of the Xe lamp. 
 
Open shutter after: This is the delay after the start of the experiment that the shutter in front of the Xe lamp is 
opened. This value can be entered directly into the edit box or adjusted using the arrowed buttons. The time 
increment for each arrow click is 1.0 s. Changes made with the arrows are implemented immediately, however 
directly-entered text is only implemented when the Apply button has been pressed. 
 
for: This is the time that the shutter will be open. As before, this value can be entered directly into the edit box 
or adjusted using the arrowed buttons. The time increment for each arrow click is 1.0 s. Changes made with 
the arrows are implemented immediately, however directly-entered text is only implemented when the Apply 
button has been pressed. 



Spectral Data Acquisition 
 

 
Any directly-entered text in the text boxes will be implemented when the Apply button is pressed. On clicking 
Start, all sample values are rounded to their hardware device resolution, then checked against their legal 
range. Any illegal values will be notified and a scan cannot start until these have been remedied. The dialog 
box is closed by pressing the Cancel button. 
 
Sample Set Up: Pressing this button will permit the setting of the parameters for the sample currently selected 
in the Sample radio group. The dialogs for this purpose are shown in Figure 5.16. 
 
 

 
(b) 

 
 

(a) 
 
 
 
  

(c) 

Figure 5.14: Kinetic scan sample set up dialogs with (a) Mode tab, (b) Excitation tab and (c) Emission tab 
shown. 

 
 
There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 5.14(a) and it permits the user to select the measurement mode, 
based on the system geometry, for the measurement. 
 
Excitation: This tab is shown in Figure 5.14(b) and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Light Source radio group is used to select the source to be used in the experiment. 
 

d. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 
the Iris Setting dialog box. 
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e. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 

Emission: This tab is shown in Figure 5.14(c) and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Detector radio group is used to select the detector to be used in the experiment. 
 

d. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 
 
5.2.5 Cryostat Temperature Scan 

This measurement requires an Oxford cryostat and temperature controller and these settings need to be made 
in the hardware configuration (Chapter 3) before the menu item for a temperature scan become available. The 
instructions for set-up and use of a cryostat may be found in the cryostat manuals supplied. A temperature 
scan measures the fluorescence of a sample at fixed excitation and emission wavelengths over a temperature 
range.  
 
To perform a temperature scan, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Temperature Scan. The temperature scan dialog box then 
appears  (Figure 5.15). Although it is normal practice to use the Signal Rate screen to set up the 
instrumentation prior to commencing a measurement, some parameters can also be set in the scan setup 
screens, as will be seen. 
 
During the temperature scan, the cryostat takes the temperature to the lowest point in the temperature range. 
Once the cryostat has reached the temperature, it has to stay within a preselected temperature range for a 
given time to make sure of its stability, the emission is then measured for a given time. The temperature in the 
cryostat sample holder then increases to the next step in the scan. These settings are altered in the 
Temperature Scan Parameters box (Figure 5.15). The parameters that can be entered here are: 
 
Scan From/To/Step: Enter the temperature range of interest in Kelvin (Scan from/to) and the number of 
degrees Kelvin between each measurement (Step). 
Stabilisation Time: Enter the time that the cryostat has to stay at each temperature before a measurement is 
acquired. 
 
Accuracy Band: Enter the temperature tolerance range (in Kelvin) within which is the temperature is assumed 
to be stable. 
 
Dwell Time: Enter the time data is acquired at each wavelength in seconds. 
 
Auto PID: The Proportional, Integral and Derivative settings can either be set manually on the cryostat 
controller or selected automatically from the learnt characteristics of the system by means of the Auto PID 
check box in the Temperature Scan Parameters. When the cryostat temperature is set to go to a higher 
temperature, the temperature increase has a hysteresis profile. This is one of the reasons for a stabilisation 
time. In order to minimise the hysteresis while maximising the speed of the temperature increase, the 
proportional, integral and derivative settings can be altered. We recommend that the temperature controller 
automatically sets these. More information on this can be found in the cryostat instruction manuals. 
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Figure 5.15: Temperature Scan Setup Dialog box 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked.  
 
If an optional T-Geometry system is being used, Measurement Mode radio buttons are present. If L1 is 
selected, Emission channel 1 will be used (i.e. data will be acquired from the detector set up to be used on 
emission channel 1). If L2 is selected, Emission channel 2 will be used (i.e. data will be acquired from the 
detector set up to be used on emission channel 2). If T is selected, data will be acquired from emission 
channels 1 and 2 sequentially. Using a T measurement mode a wavelength offset can be applied between 
emission channels 1 and 2. The offset is set on the emission 2 tab. 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
On the General tab, select the required measurement mode and the correction to be applied to the data. 
Since the excitation and emission wavelengths are fixed, the spectral correction files need not be used. To 
correct for any variation in lamp intensity over the course of the measurement, the Measure Simultaneously 
box should be checked. Checking this setting will mean that the excitation light intensity is measured by the 
reference detector simultaneously with the emission detector. This option takes account of variations in light 
source intensity with time as well as spectral variation.  
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Figure 5.16: Temperature Scan Excitation Tab 
 
On the Excitation tab (Figure 5.16), the values for the monochromator wavelength, slit bandwidth, lamp 
source and polariser that were set in the Signal Rate screen are displayed. If desired, the monochromator 
wavelength, lamp source and optional polarisers, if fitted, can be further modified. 
 
 

 

Figure 5.17: Temperature Scan Emission Tab 
 
On the Emission tab(s)  (Figure 5.17), the values for the slit bandwidth, detector and polariser that were set in 
the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified. 
 
 
 

5.3 Correction Scans 
Spectral correction is necessary to obtain the true excitation and emission spectra of the sample, free from any 
instrumental effects. Comprehensive spectral correction, using previously measured correction files, is 
standard practice when using fluorescence spectrometers. 
 
 
5.3.1 Emission Correction Scan 

Raw emission spectra are affected by the monochromator efficiency and the spectral response of the detector. 
Unique correction files for each spectrometer are obtained during calibration at the Edinburgh Instruments 
factory using calibrated light sources. However, if the need arises to measure additional emission correction 
files (for instance, if a new detector is installed onto the system) you must firstly obtain the appropriate 
calibrated sources from Edinburgh Instruments Ltd. Once you are in receipt of these, proceed in the following 
manner to measure a new emission correction file. 
 
Attach the calibration source to the side of the sample chamber at 90o to the emission channel. Place a highly 
scattering object (such as a PTFE scatterer) in the sample holder at 45o to the  calibration lamp and emission 
monochromator. 
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Figure 5.18: Emission Correction Dialog Box 
 
 
To perform an emission correction scan, click the File main menu item, then select New Spectral 
measurement. This will display a drop-down menu. From this menu, select Correction Scan and on the pop-
up menu click the required emission arm to be measured. The emission correction dialog box will be opened 
(Figure 5.18). The following items can be edited: 
 
Lamp Source: Enter a description for the calibration source (e.g. Tungsten or Deuterium). 
 
Polariser: If polarisation is to be used then check the In box and select the Angle from Vertical from the 
available options. 
 
Detector: Select a detector from the options available. 
 
Scan from/to/step: Enter the wavelength scanning range and the size of the step. 
 
Dwell Time: Enter the dwell period at each wavelength. 
 
Number of Scans: Enter the number of times that the scan has to be repeated and summed. 
 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
 
As the calibration source has its own spectral profile, the data measured has to be divided by this profile 
before it can be used as a correction file. 
 
Tip: 
The spectral range of an emission correction file may be extended by measuring the response of two different 
calibration sources (e.g. Tungsten and Deuterium), dividing the measurement with their source profiles and 
then appending the resulting sets of data. 
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5.3.2 Excitation Correction Scans 

Uncorrected excitation spectra are effected by the spectral output of the light source and the throughput of the 
monochromator. The correction file is obtained by using the built-in calibrated reference detector that monitors 
a fraction of the excitation light. This scan requires specific settings to be made for the monochromator. To set 
these, go to the Signal Rate menu and enter the following values: 
 

a) Set the excitation wavelength to 473 nm. 
 
b) Set the spectral resolution of the slits to 1 nm (equivalent to 0.55 mm for a single monochromator with 

an 1800 grooves/mm grating). 
 
 

 

Figure 5.19: Excitation Correction Dialog Box 
 
To perform an emission correction scan, click the File main menu item, then select New Spectral 
measurement. This will display a drop-down menu. From this menu, select Correction Scan and on the pop-
up menu click  Ex (Ref. Detector) The excitation correction scan setup dialog box is then opened (Figure 
5.19). The following items can be edited: 
 
Lamp Source: Select the required excitation source (normally Xe Lamp). 
 
Polariser: If required, create correction scans for various excitation polarisations can be created, but for the 
standard correction file, the polariser is left out of the beam path. 
 
Scan from/to/step: Enter the wavelength scanning range and the size of the step. These values should 
normally be: From = 200 nm, To = 900 nm, Step = 1 nm (for a 1800 grooves/mm grating blazed at 500 nm). 
 
Dwell Time: Enter the dwell period at each wavelength. This should normally be set to 0.2 s. 
 
Number of Scans: Enter the number of times that the scan has to be repeated and summed. This should 
normally be set to 5. 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against their 
legal range. Any illegal values will be notified and a scan cannot start until these have been remedied.  
 
Once the scan has been completed it should be saved in folder location C:\Program Files\EAI\Correction.  
 
In order to install the correction file so that it is used by the software, follow these steps: 
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a. On the F900 main menu bar go to Options/Correction Files.  
 

b. Go to the Excitation tab and click the Modify button.  
 

c. Using the open dialog box, locate the correction file you saved, i.e. in C:\Program 
Files\EAI\Correction.  

 
d. The path to the correction file should now appear below ‘Ex Correction File’, if so click Ok  

 
e. The software should now be configured to work with the new correction file.  

 
Notes 
 
The Silicon reference detector should be limited to 200 -1100 nm. 
 
The excitation correction file should be repeated periodically and when a bulb is changed, as pressure 
broadening can occur with the Xenon spectral lines. 
 
 

5.4 Map measurements 

5.4.1 Emission Map  

Map measurements consist of a pre-defined set of basic scans, each done at a different physical attribute. An 
emission map performs a set of emission scans for a set of pre-defined excitation wavelengths.  
 

 

Figure 5.20: Emission Map Dialog Box with general tab shown. 
 
To perform an emission map, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Emission Map. The emission map dialog box then appears 
(Figure 5.20). Although it is normal practice to use the Signal Rate screen to set up the instrumentation prior 
to commencing a measurement, some parameters can also be set in the scan setup screens, as will be seen. 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
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measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked.  
 
 

 

Figure 5.21: Excitation tab for an emission map. 
 
 

 

Figure 5.22: Emission tab for an emission map. 
 
 
On the General tab select what correction, if any, is to be applied to the data. The correction options are: 
 

Ex Correction Value: This setting corrects for the excitation profile of the spectrometer. 
Em1 Correction File Data: This setting corrects for the spectral response of the emission 
monochromator and detector. 
Measure Simultaneously: Checking this setting will mean that the excitation light intensity is measured 
by the reference detector simultaneously with the emission detector. This option takes account of 
variations in light source intensity with time as well as spectral variation. Simultaneously measuring the 
reference detector is quite often a more accurate option, since if the monochromator slit sizes are 
different from the size they were when the excitation correction file was made, the spectral resolution of 
the monochromator will alter and therefore the lines of the Xenon spectra measured can be broadened 
or narrowed. 

 
The standard 450 W Xenon lamp used in the spectrometer is very stable, therefore if correction is required for 
emission scans, only the Em1 Correction File Data check box need be ticked. When any emission correction 
is ticked, the software automatically selects the correct file depending on which detector is being used to 
acquire the data. 
 
In the Emission Map Parameters box, the following parameters can be entered: 
 
Ex scan from/to/step: Enter the excitation wavelength scanning range and step size. 
 
Em scan from/to/step:  Enter the emission wavelength  scanning range and step size. 
 
Dwell Time: Enter the dwell time at each wavelength. 
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Number of scans: Enter the number of times that the scan is to be repeated and summed. 
 
 
The number of emission scans that will be completed in order to construct the map will be the number of steps 
in the excitation wavelength range. 
 
On the Excitation tab (Figure 5.21), the values for the slit bandwidth, lamp source and polariser that were set 
in the Signal Rate screen are displayed. If desired, the lamp source and optional polarisers, if fitted, can be 
further modified. 
 
On the Emission tab(s) (Figure 5.22), the values for the slit bandwidth, detector and polariser that were set in 
the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified. By default, if the scan ranges of the excitation and emission monochromators overlap then it is 
possible for the excitation wavelength to be greater than the emission wavelength. If this is not desired then 
the Em1 start > Ex box should be checked and a value entered in the Start offset edit box. The effect of this 
will be to override the settings in the Emission Map Parameters box by ensuring that the emission 
wavelength starts at the offset value greater than the excitation wavelength. 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
 
5.4.2 Synchronous Map 

To perform a synchronous map, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Synchronous Map. The synchronous map dialog box then 
appears (Figure 5.23). Although it is normal practice to use the Signal Rate screen to set up the 
instrumentation prior to commencing a measurement, some parameters can also be set in the scan setup 
screens, as will be seen. 
 
If the optional sample positioner is being used, the Position radio buttons and a group of  Measure check 
boxes are available. The Position radio buttons allow scans to be set up differently for each sample to be 
measured. When the measurement is started, the samples measured are dependent on which Measure check 
boxes have been ticked. 
 
 
On the General tab select what correction, if any, is to be applied to the data. The correction options are: 
 

Ex Correction Value: This setting corrects for the excitation profile of the spectrometer. 
Em1 Correction File Data: This setting corrects for the spectral response of the emission 
monochromator and detector. 
Measure Simultaneously: Checking this setting will mean that the excitation light intensity is measured 
by the reference detector simultaneously with the emission detector. This option takes account of 
variations in light source intensity with time as well as spectral variation. Simultaneously measuring the 
reference detector is quite often a more accurate option, since if the monochromator slit sizes are 
different from the size they were when the excitation correction file was made, the spectral resolution of 
the monochromator will alter and therefore the lines of the Xenon spectra measured can be broadened 
or narrowed. 

 
The standard 450 W Xenon lamp used in the spectrometer is very stable, therefore if correction is required for 
emission scans, only the Em1 Correction File Data check box need be ticked. When any emission correction 
is ticked, the software automatically selects the correct file depending on which detector is being used to 
acquire the data. 
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Figure 5.23: Synchronous map dialog box with general tab shown. 
 
 
In the Emission Map Parameters box, the following parameters can be entered: 
 
Ex scan from/to/step: Enter the excitation wavelength scanning range and step size. 
 
Em scan from/to/step:  Enter the emission wavelength  scanning range and step size. 
 
Dwell Time: Enter the dwell time at each wavelength. 
 
Number of scans: Enter the number of times that the scan is to be repeated and summed. 
 
 
The number of emission scans that will be completed in order to construct the map will be the number of steps 
in the excitation wavelength range. 
 
On the Excitation tab (Figure 5.24), the values for the slit bandwidth, lamp source and polariser that were set 
in the Signal Rate screen are displayed. If desired, the lamp source and optional polarisers, if fitted, can be 
further modified. 
 
On the Emission tab(s) (Figure 5.25), the values for the slit bandwidth, detector and polariser that were set in 
the Signal Rate screen are displayed. If desired, the detector and optional polarisers, if fitted, can be further 
modified.  
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
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Figure 5.24: Excitation tab for a synchronous map. 
 
 

 

Figure 5.25: Emission tab for a synchronous map. 
 
 
 
5.4.3 Temperature Map 

The temperature map scan requires an Oxford cryostat and temperature controller to be present. To perform a 
temperature map, click the File main menu item, then select New Spectral measurement. This will display a 
drop-down. From this menu select Temperature Map. The temperature map dialog box then appears (Figure 
5.26).  
 
The parameters that can be set are: 
 
Scan Type: Select the type of scan to be performed from the selection of radio butoons available. The scan 
can then be set up by pressing the … Scan Setup button. This will open the menus described in Section 5.2.1 
(for emission scans), Section 5.2.2 (for excitation scans) or Section 5.2.3 (for synchronous scans). 
 
Scan From/To/Step: Enter the temperature range of interest in Kelvin (Scan from/to) and the number of 
degrees Kelvin between each measurement (Step). 
 
Stabilisation Time: Enter the time that the cryostat has to stay at each temperature before a measurement is 
acquired. 
 
Accuracy Band: Enter the temperature tolerance range (in Kelvin) within which is the temperature is assumed 
to be stable. 
 
Auto PID: The Proportional, Integral and Derivative settings can either be set manually on the cryostat 
controller or selected automatically from the learnt characteristics of the system by means of the Auto PID 
check box in the Temperature Scan Parameters. When the cryostat temperature is set to go to a higher 
temperature, the temperature increase has a hysteresis profile. This is one of the reasons for a stabilisation 
time. In order to minimise the hysteresis while maximising the speed of the temperature increase, the 
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proportional, integral and derivative settings can be altered. We recommend that the temperature controller 
automatically sets these. More information on this can be found in the cryostat instruction manuals. 
 
 

 

Figure 5.26: Temperature map dialog box. 
 
 
On clicking Start, all sample values are rounded to their hardware device resolution, then checked against 
their legal range. Any illegal values will be notified and a scan cannot start until these have been remedied. 
 
Select the required cryostat control mode when prompted. 
 
 
 

5.5 Anisotropy measurements (performed using optional 
polarisers) 

If optional, computer controlled polarisers (P920) are present, anisotropy scans for both emission scans and 
excitation scans can be performed. When fluorescent samples are excited by polarised light, photoselection of 
the fluorophores results, depending on their orientation relative to the direction of polarisation of the light. 
 
Principally, an anisotropy calculation can be made without G-factor correction by loading the .VV and .VH files 
only. However, because the G-factor is dependent on the emission wavelength, the user should apply the G-
factor correction to the fluorescence anisotropy calculation. The G-factor (which is a G-factor file in steady 
state spectroscopy) is calculated from the .HV and .HH files as follows: 
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5.5.1 Emission Anisotropy Scan 

To perform an emission scan, click the File main menu item, then select New Spectral measurement. This 
will display a drop-down. From this menu select Anisotropy Scan. From the pull-down menu select Emission. 
The emission anisotropy scan dialog box then  An emission anisotropy scan is set up in the same manner as a 
normal emission scan. Please see Section 5.2.1 for instructions on how to do this. Additionally there is a tab 
containing settings for the anisotropy measurements (Figure 5.27). 
 
 

 

Figure 5.27: Anisotropy tab for an emission scan. 
 
 
The anisotropy dialogue box allows the user to set up  the procedure used to make an anisotropy 
measurement in the measurement screen [Measure - Anisotropy]. 
 
For measurements in L geometry only the two excitation polariser options and one emission polariser option 
(V then H) is active. 
 
If the vertical polarisation direction is selected for the excitation channel the spectrally resolved fluorescence 
intensities IVV and IVH will be sequentially measured. If the horizontal polarisation direction has been selected 
the excitation scans IHV and IHH, required for G-factor correction, will be sequentially measured  
 
In T-geometry, six different modes of automatic polarised fluorescence measurements can be set up, with 
three of them used to measure curves in order to determine the G-factor. 
 
The anisotropy set-up dialogue box sets up anisotropy measurements to be measured in the measurement 
screen [Measure - Anisotropy]. 
 
If the vertical polarisation direction is selected for the excitation channel and the first of the three options is 
selected for the emission channels then IVV and IVH will be respectively and simultaneously measured at the 
two emission arms. 
 
If the vertical polarisation direction is selected for the excitation channel and the second of the 3 options is 
selected for the emission channels IVV and IVH  will be measured at emission arm 1 subsequently, whereas a 
user defined polarised measurement will be made simultaneously in the second emission arm. 
If the vertical polarisation direction is selected for the excitation channel and the last of the 3 options is 
selected for the emission channels the spectrally resolved fluorescence intensities IVV  will be measured at 
both emission arms simultaneously and IVH will be measured for both arms afterwards. 
 
The measurements for horizontal oriented polariser in the excitation channel are similar to the measurements 
described above. They are used to make the G factor correction. 
 
All polarised measurements are stored automatically with the file extensions “.VV”, “.VH”, “.HV”, and “.HH”, 
dependent upon the orientation of the excitation and emission polarisers. 
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5.5.2 Excitation Anisotropy Scan 

To perform an excitation anisotropy scan, click the File main menu item, then select New Spectral 
measurement. This will display a drop-down. From this menu select Anisotropy Scan. From the pull-down 
menu select Excitation. The excitation anisotropy scan dialog box then appears  An excitation anisotropy 
scan is set up in the same manner as a normal emission scan. Please see Section 5.2.2 for instructions on 
how to do this. Additionally there is a tab containing settings for the anisotropy measurements (Figure 5.28). 
 
 
 

 

Figure 5.28: Anisotropy tab for an excitation scan. 
 
 
For an excitation scan (where the G-factor file should be constant) the G-factor can be modified in the G 
Factor box. 
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6 Acquiring Lifetime Data 
If the spectrometer system is fitted with a TCC900 card the lifetime measurements can be performed. As with 
spectral measurements, the Signal Rate dialog box is used to prepare the instrumentation setups for an 
experiment. Details of the Signal Rate settings can be found in Section 5.1. Once the hardware settings have 
been completed, the measurement parameters can be set by selecting the New Lifetime Measurement menu 
item in the File header, or by pressing the Lifetime Measurement toolbar button. This will open the following 
options: 
 
 
 
 
 
 
 
 
 
 
 
 
 
These options will now be described in greater detail. 
 
 

6.1 Manual Lifetime 
When Manual Lifetime is selected then a dialog box similar to the one shown in Figure 6.2 will open: 
 

Figure 6.2: Manual lifetime dialog box with Mode 
geometry options selected. 

 

This box permits the user to: 

a. Start a measurement by pressing the New button. 

 

Figure 6.1: Lifetime measurement options
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b. Temporarily halt a measurement sequence by pressing the Pause button. 

c. Permanently halt a measurement by pressing the Stop button. 
 

d. Choose whether data should be displayed in the currently active data window (Add) or be shown in a 
new window (New). 

 
e. For systems with multiple sample chamber positions, the desired position can be selected using the 

Set up Sample radio group. 
 

f. If the purpose of the measurement is to obtain the system response, without any sample present, 
then the IRF checkbox can be ticked to indicate that the data can be used in deconvolution to remove 
the effect of the measurement system from acquired sample data. 

 
g. If the Live check box is ticked then monochromator wavelengths can be changed during the course 

of a measurement, otherwise they are only changed at the beginning of a measurement. 
 
 
Pressing the Apply button makes any changes effective and pressing the Close button will close the dialog 
box. 
 

Figure 6.3: Manual lifetime dialog box with 
Excitation monochromator options selected. 

Figure 6.4: Manual lifetime dialog box with 
Emission monochromator options selected. 

 
 
In addition to the changes described above, instrumentation changes can also be performed in this box, 
although it is recommended that these changes are made with the Signal Rate dialog box wherever possible. 
There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 6.2 and it permits the user to select the measurement mode, based 
on the system geometry, for the measurement. 
 
Excitation: This tab is shown in Figure 6.3 and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 
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b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 
the desired angle from the options available. 

 
c. The Light Source radio group is used to select the source to be used in the experiment. 

 
d. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 

the Iris Setting dialog box. 
 

e. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 

Emission: This tab is shown in Figure 6.4 and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Detector radio group is used to select the detector to be used in the experiment. 
 

d. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 

6.2 Card Settings 
Depending on the lamp selection, one of the dialog boxes shown in Figure 6.5 and Figure 6.6 will be displayed 
below the Manual Measurement dialog box. If a microsecond flashlamp is used then the measurement will be 
made with the PCS card operating in MCS (Multi-Channel Scaling) mode and the dialog box shown in Figure 
6.5 will be available. The options are: 
 

Time Range: This is the overall duration of a single measurement and is selectable from the options in 
the drop-down box. The values range from 100 µs to 200 s in sequences of 1-2-4-8. 
 
Channels: This value is the number of channels to be measured over the time range. The available 
options are 500, 1000, 2000, and 4000 channels. 
 
Lamp Trigger Delay: This value is the delay (in ms) of the lamp trigger with respect to trigger signal to 
the MCS card that commences an acquisition. It is used to adjust the  position the measured data on the 
data plot so that the data is clearly shown. The setting can be adjusted from 0.001 ms to 90.000 ms in 
steps of 0.001 ms. 
 
Stop condition: The setting is used to determine the stop condition for the measurements. There are 
three possible ways of setting the stop condition and these are: 
 

a. Sweeps:  This setting stops the measurement after the entered number of sweeps (single 
measurements) have been completed. Pressing the Apply button will display the time required 
for the entered number of sweeps to be performed. 

 
b. Time: This setting stops the measurement after the specified time has elapsed. Note that the 

entered time is adjusted by the software to ensure that an integral number of sweeps have been 
performed. Pressing the Apply button will perform this correction without starting the 
measurement. 
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c. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
 

 

 

 

Figure 6.5: Multi-Channel Scaling (MCS) 
measurement options. 

Figure 6.6: Time-Correlated Single Photon 
Counting (TCSPC) options. 

 

If the nanosecond flashlamp or the steady-state lamp are used then measurements will be performed with the 
TCSPC card and the dialog box shown in Figure 6.6 will be visible. The dialog box has three tabs whose 
contents are shown in each of the snapshots of the figure. The settings for the Time Range  and Stop 
Condition are: 
 

Time Range: This is the overall duration of a single measurement and is selectable from the options in 
the drop-down box. The values range from 2.5 ns to 50 µs in sequences of (after the 2.5 ns value) 1-2-5. 
 
Channels: This value is the number of channels to be measured over the time range. The available 
options are 512, 1024, 2048, 4096 channels. 

 
Stop condition: The setting is used to determine the stop condition for the measurements. There are 
three possible ways of setting the stop condition and these are: 
 

a. Time: This setting stops the measurement after the specified time has elapsed.  
 

b. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
c. Manual: With this option the user has to stop the measurement manually by pressing the Stop 

button. This will override any entered values of Peak Counts, Time or External. 
 

d. External: This setting requires that an external interrupt signal is required to stop the 
measurement. This signal is applied to the control port of the TCC-900 card. 
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The values displayed in the Rates tab are read-only with the Start Rate value displaying the signal frequency 
at the Start input of the TCC-900 card and the Stop Rate displaying the signal frequency at the Stop input of 
the TCC-900 card. 
 
Pressing the Options button will open a dialog box to change the settings for the TCC-900 card. There are 
four tabs on the dialog box and these are shown in Figure 6.7. 
 
 

 
(a) 

 
 
 
 
 

(b) 

 
(c) 

 
(d) 

Figure 6.7: TCC-900 card settings (a) Constant Fraction discriminator (CFD), (b) Time range, (c) Rate Display, and (d) 
Mode. 

 
CFD  
 
The Constant Fraction discriminator (CFD) set-up is important in detector / electronics optimisation work, in 
particular when the TCSPC module has been recently installed or when a new detector is to be set up. Both 
Start and Stop inputs of the TCC-900 card have a CFD to temporally optimise and shape the incoming pulses. 
Both CFDs can be set up independently. The majority of the CFD parameters can be optimised by software. 
Only one CFD parameter, the CFD Delay, must be set manually by replacing a delay plug on the TCC900 
card. The software settable values are: 
 

a. Threshold: The threshold can be set in the range 0 to –2000 mV in steps of 1 mV. As a 
general rule, select a value about 10% of the average pulse height of the input pulses (pulses 
from a trigger diode will not have a large pulse height fluctuation, whereas those from a 
photomultiplier will have a much greater variation). 
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b. Zero Crossing: The zero crossing can be set in the range of –100 mV to 100 mV in steps of 

0.05 mV. As a general rule, start with a small negative value e.g. –3 mV, 
 

c. Divider: The divider can have values of 1, 2, 4, or 8. Generally, start  with a value of 1. 
 
All the above parameters need to be optimised in order to achieve good measurement results, e.g. in respect 
to the pulse width of the instrument response, to the ratio of the number of dark counts to the number of signal 
counts, to the elimination of RF and interference problems etc.  
 
The CFD delay also needs to be optimised for the best measurement result. As a general rule the CFD delay 
should be about 70% of the pulse rise time. Different delay plugs are supplied with the TCC-900 card. The 
standard CFD delay plugs fitted to both the Start and the Stop channels are 1.0ns and 0.2ns, respectively. If 
these values are not appropriate for the particular detector, than they can easily be changed. To do this the 
card needs to be removed from the computer. Once this has been done, the two brown delay plugs (one for 
the Start the other for the Stop channel) can be located at the edge of the TCC-900 card. To change simply 
unplug the original plug and insert the new plug.  
 
The Divider is not strictly a CFD parameter, but it may be needed when the TCC-900 card is operating in 
Reverse mode. By using the original (laser) repetition rate in reverse TCSPC operation only one period of the 
high repetition signal can be seen. This may be inconvenient  when measuring in a time range close to the 
inverse of the (laser) repetition rate. By changing the divider to either 2, 4, or 8, more than just one signal 
periods can be measured. Note that the settings of the Divider will not have an impact on the displayed signal 
rate, it will only be apparent when acquiring the lifetime data. 
 
 
Time Range Settings 
 
When the TCC-900 card has been set for the first time and one is at the stage that signal rates are displayed, 
the most likely difficulty is firstly finding the measurement on the measurement display and secondly  
positioning the rising edge close to the left side of the window. Changing either of the two required shift 
parameters will shift the entire measurement (decay and/or IRF measurement) either to the left or to the right 
on the measurement window. The parameters are: 
 

a. Shifting Delay: This is essentially a series of wire delays integrated in the TCC-900 card. Generally, 
for large time ranges (above 100 ns) a shifting delay is required in order to shift the measurement to 
the right to cover the full lifetime measurement, including the rising edge. For short time ranges a 
small shifting delay may be required in order to compensate for the different cable lengths in the start 
and stop channels. By correctly “placing” the measurement, full use of the x-axis resolution can be 
made. A large shifting delay is further required when working in Reverse mode. In this mode the 
exciting light pulse (usually a laser pulse) needs to be shifted in time to arrive at the TC-900 card later 
than latest expected decay photon, i.e. the shifting delay must be slightly longer than the selected 
time range.  

 
b. TAC Offset: The TAC offset can also be used to shift the measurements. The default setting is 500 

ns. Values between 300 ns and 1000 ns should only be used for time ranges above 5ns. For the two 
shortest time ranges (2.5 ns and 5.0 ns) the offset spans from 1200 ns to 4000 ns. 

 
Once the Time Range Settings box has been closed the selected delay value will always be active for the 
particular time range. Other time ranges maintain the old delay values. 
 
 
 
 
Rate Display 
 
The Rate Display tab permits the changing of the format of the count rate (per seconds) on the main data 
acquisition screen. The frequency counters on the TCC-900 card can not measure frequencies above 10 MHz 
correctly. When working with high synchronisation frequencies either kHz or MHz should be chosen, otherwise 
the display will be wrong. 
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Mode 
 
This tab allows the user to change between Forward and Reverse mode. The change will affect the x-axes of 
the display, which is effectively reversed when changing between the two modes. If one chooses to work in the 
Reverse mode, the laser synchronisation frequency (the higher of the two rates) must be connected to the 
Stop input of the TCC-900 card. Alternatively when working in the forward mode the source synchronisation 
frequency needs to be connected to the Start channel. 
 
 
 

6.3 Multiple 
It is possible to perform a sequence of measurements within a single sequence and the multiple lifetime 
measurement dialog box (shown in Figure 6.8) is used for this purpose. 
 

 

Figure 6.8: Dialog box for multiple lifetime measurements. 

 

The constituents of this dialog box are: 
 
Set up Sample Position: This radio group is use to select the sample position that is to be modified by 
pressing the Sample Set Up button. The options are only available if the multiple sample holder has been 
installed. 
 
Measure Samples: To include the sample in a particular position, the corresponding check box should be 
clicked.  
 
Interleave samples: Interleaving affects the order in which samples are measured during automated lifetime 
measurements. If the measurements are interleaved, the first measurement is made from each of the selected 
samples, then the second from each, then the third from each, and so on until all acquisitions are made from 
all samples. If one of the samples is specified as an instrument response, acquisitions from this container will 
be copied into the containers of the sample measurements on completion. If the measurements are not 
interleaved, all measurements are completed with a selected sample before passing on to the next. There is 
no combination of instrument response data with other containers. 
 
Instrument Response: Checking this box will indicate to the software that the measurement sequence is for 
an instrument response scan and the plotted data will be flagged accordingly. 
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Measure this sample…: This edit box permits the user to enter the number of times that a particular sample 
should be measured. 
 
Save data each time: Checking this box will save data each time a measurement is made and will display the 
measurements separately. Alternatively, the measurements will be aggregated together into a single plot. 
 
Wait for…: Entering a value in this box will pause the measurement for the specified time. This is to permit the 
user to make changes to the sample(s), for example in chemical concentrations. 
 
 
Pressing the Start button will commence the measurement and pressing the Cancel button will close the 
dialog box without performing any measurements. 
 
 
 
6.3.1 Sample Set Up Button 

 
Pressing this button will open the dialog box shown in Figure 6.9. 
 
 

 
(b) 

 
 

(a) 
 
 
 
  

(c) 

Figure 6.9: Multiple measurement sample set up dialogs with (a) Mode tab, (b) Excitation tab and (c) Emission 
tab shown. 

 

There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 6.9(a) and it permits the user to select the measurement mode, based 
on the system geometry, for the measurement. 
 
Excitation: This tab is shown in Figure 6.9(b) and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 
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f. The monochromator wavelength can be changed in the Wavelength edit box by either entering 
a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
g. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

h. The Light Source radio group is used to select the source to be used in the experiment. 
 

i. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 
the Iris Setting dialog box. 

 
j. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-

hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 

Emission: This tab is shown in Figure 6.9(c) and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
e. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
f. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

g. The Detector radio group is used to select the detector to be used in the experiment. 
 

h. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 
6.3.2 Time Set Up Button 

Pressing the Time Set Up button opens either the dialog box shown in Figure 6.10 (for measurements made 
with the steady-state or nanosecond flashlamps) or Figure 6.11 (for measurements made with the 
microsecond flashlamp). 
 
The settings for the Time Range  and Stop Condition tabs are: 
 

Time Range: This tab is used to set the timing conditions for the measurement. 
 

a. Time Range: This is the overall duration of a single measurement and is selectable from the 
options in the drop-down box. The values range from 2.5 ns to 50 µs in sequences of (after the 
2.5 ns value) 1-2-5. 

 
b. Channels: This value is the number of channels to be measured over the time range. The 

available options are 512, 1024, 2048, 4096 channels. 
 

 
Stop condition: The tab is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 
 

a. Time: This setting stops the measurement after the specified time has elapsed.  
 

b. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 
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c. Manual: With this option the user has to stop the measurement manually by pressing the Stop 
button. This will override any entered values of Peak Counts, Time or External. 

 
d. External: This setting requires that an external interrupt signal is required to stop the 

measurement. This signal is applied to the control port of the TCC-900 card. 
 
 

 
(a) 

 
 
 
 
 

(b) 

Figure 6.10: Multiple measurement time set up dialogs for TCSPC mode measurements showing (a) Time 
Range tab and (b) Stop Condition tab.  

 
 
Pressing the Options button will open the TCC-900 settings dialog box. This is described in Section 6.2. 
 
 

 

Figure 6.11: Multiple measurement time set up dialog box for 
MCS measurements. 

 
 
The items in the MCS Measurement dialog box are: 
 
Time Range: This is the overall duration of a single measurement and is selectable from the options in the 
drop-down box. The values range from 100 µs to 200 s in sequences of 1-2-4-8. 
 

Channels: This value is the number of channels to be measured over the time range. The available options 
are 500, 1000, 2000, and 4000 channels. 
 

Lamp Trigger Delay: This value is the delay (in ms) of the lamp trigger with respect to trigger signal to the 
MCS card that commences an acquisition. It is used to adjust the  position the measured data on the data plot 
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so that the data is clearly shown. The setting can be adjusted from 0.001 ms to 90.000 ms in steps of 0.001 
ms. 
 

Stop condition: The setting is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 

 
a. Sweeps:  This setting stops the measurement after the entered number of sweeps (single 

measurements) have been completed. Pressing the Apply button will display the time required for the 
entered number of sweeps to be performed. 

 
b. Time: This setting stops the measurement after the specified time has elapsed. Note that the entered 

time is adjusted by the software to ensure that an integral number of sweeps have been performed. 
Pressing the Apply button will perform this correction without starting the measurement. 

 
c. Peak Counts: The setting permits the user to stop the measurement once a specified number of 

counts have been received on the (by default) highest amplitude channel of the data. If desired, the 
channel that the peak counts are measured can be specified by the user. 

 
 

6.4 TRES 
Time-Resolved Emission Scans (TRES) are used to examine how lifetime decay change with wavelength. 
They are performed by measuring decay over a pre-defined set of equally-spaced wavelengths. The dialog 
boxes use for this purpose are shown in Figure 6.12. 
 
 

 
(a) 

 
(b) 

Figure 6.12: Dialog boxes for measuring (a) TRES excitation scans and (b) TRES emission scans. 

 

The common constituents of these dialog boxes are: 
 
Set up Sample Position: This radio group is use to select the sample position that is to be modified by 
pressing the Sample Set Up button. The options are only available if the multiple sample holder has been 
installed. 
 
Measure Samples: To include the sample in a particular position, the corresponding check box should be 
clicked.  
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Interleave samples: Interleaving affects the order in which samples are measured during automated lifetime 
measurements. If the measurements are interleaved, the first measurement is made from each of the selected 
samples, then the second from each, then the third from each, and so on until all acquisitions are made from 
all samples. If one of the samples is specified as an instrument response, acquisitions from this container will 
be copied into the containers of the sample measurements on completion. If the measurements are not 
interleaved, all measurements are completed with a selected sample before passing on to the next. There is 
no combination of instrument response data with other containers. 
 
Instrument Response: Checking this box will indicate to the software that the measurement sequence is for 
an instrument response scan and the plotted data will be flagged accordingly. 
 
Wavelength Setup: For an Excitation TRES measurement the wavelength of the emission monochromator is 
fixed whilst the wavelength of the excitation monochromator is varied. The start, stop and step (increment) 
wavelengths are entered in this group box, as can be seen in Figure 6.12(a). For emission TRES 
measurements it is the excitation monochromator wavelength that is allowed to change and the emission 
monochromator whose wavelengths are changed. The box to do this is shown in Figure 6.12(b). 
 
 
Pressing the Start button will commence the measurement and pressing the Cancel button will close the 
dialog box without performing any measurements. 
 
 
6.4.1 Sample Set Up Button 

Pressing this button will open the dialog box shown in Figure 6.13. 

 

There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 6.13(a) and it permits the user to select the measurement mode, 
based on the system geometry, for the measurement. 
 
Excitation: This tab is shown in Figure 6.13(b) and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Light Source radio group is used to select the source to be used in the experiment. 
 

d. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 
the Iris Setting dialog box. 

 
e. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-

hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 
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(b) 

 
 

(a) 
 
 
 
  

(c) 

Figure 6.13: Multiple measurement sample set up dialogs with (a) Mode tab, (b) Excitation tab and (c) 
Emission tab shown. 

 
 
Emission: This tab is shown in Figure 6.13(c) and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Detector radio group is used to select the detector to be used in the experiment. 
 

d. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 
6.4.2 Time Set Up Button 

Pressing the Time Set Up button opens either the dialog box shown in Figure 6.14 (for measurements made 
with the steady-state or nanosecond flashlamps) or Figure 6.23 (for measurements made with the 
microsecond flashlamp). 
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(a) 

 
 
 
 
 

(b) 

Figure 6.14: Multiple measurement time set up dialogs for TCSPC mode measurements showing (a) Time 
Range tab and (b) Stop Condition tab.  

 

The settings for the Time Range  and Stop Condition tabs are: 
 

Time Range: This tab is used to set the timing conditions for the measurement. 
 

a. Time Range: This is the overall duration of a single measurement and is selectable from the 
options in the drop-down box. The values range from 2.5 ns to 50 µs in sequences of (after the 
2.5 ns value) 1-2-5. 

 
b. Channels: This value is the number of channels to be measured over the time range. The 

available options are 512, 1024, 2048, 4096 channels. 
 

 
Stop condition: The tab is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 
 

a. Time: This setting stops the measurement after the specified time has elapsed.  
 

b. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
c. Manual: With this option the user has to stop the measurement manually by pressing the Stop 

button. This will override any entered values of Peak Counts, Time or External. 
 

d. External: This setting requires that an external interrupt signal is required to stop the 
measurement. This signal is applied to the control port of the TCC-900 card. 

 
 
Pressing the Options button will open the TCC-900 settings dialog box. This is described in Section 6.2. 
 
The items in the MCS Measurement dialog box are: 
 
Time Range: This is the overall duration of a single measurement and is selectable from the options in the 
drop-down box. The values range from 100 µs to 200 s in sequences of 1-2-4-8. 
 

Channels: This value is the number of channels to be measured over the time range. The available options 
are 500, 1000, 2000, and 4000 channels. 
 

Lamp Trigger Delay: This value is the delay (in ms) of the lamp trigger with respect to trigger signal to the 
MCS card that commences an acquisition. It is used to adjust the  position the measured data on the data plot 
so that the data is clearly shown. The setting can be adjusted from 0.001 ms to 90.000 ms in steps of 0.001 
ms. 
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Figure 6.15: Multiple measurement time set up dialog box for 
MCS measurements. 

 
 
 

Stop condition: The setting is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 

 
a. Sweeps:  This setting stops the measurement after the entered number of sweeps (single 

measurements) have been completed. Pressing the Apply button will display the time required 
for the entered number of sweeps to be performed. 

 
b. Time: This setting stops the measurement after the specified time has elapsed. Note that the 

entered time is adjusted by the software to ensure that an integral number of sweeps have been 
performed. Pressing the Apply button will perform this correction without starting the 
measurement. 

 
c. Peak Counts: The setting permits the user to stop the measurement once a specified number 

of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
 

6.5 Anisotropy  Lifetime 
Anisotropy lifetime measurements are used to examine the temporal development of fluorescence anisotropy. 
The dialog box used for this purpose is shown in Figure 6.16. 
 
The common constituents of these dialog boxes are: 
 
Sample: This radio group is use to select the sample position that is to be modified by pressing the Sample 
Set Up button. The options are only available if the multiple sample holder has been installed. 
 
Instrument Response: Checking this box will indicate to the software that the measurement sequence is for 
an instrument response scan and the plotted data will be flagged accordingly. 
 
Measure this Sample: Enter the number of times that the sample has to be measured. 
 
Wait for: Enter the interval between consecutive measurements. This option allows the user to make changes 
to the sample between measurements. 
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Polariser Repetition: Enter the number of polariser repetition sequences in this edit box. 
 
 

 

Figure 6.16: Dialog box for measuring anisotropy lifetime scans. 
 
 
Polariser sequence: If the vertical polarisation direction is selected for the excitation channel the spectrally 
resolved fluorescence intensities IVV and IVH will be sequentially measured. If the horizontal polarisation 
direction has been selected the excitation scans IHV and IHH, required for G-factor correction, will be 
sequentially measured. In T-geometry, six different modes of automatic polarised fluorescence measurements 
can be set up, with three of them used to measure curves in order to determine the G-factor.  
 
If the vertical polarisation direction is selected for the excitation channel and the first of the three options is 
selected for the emission channels then IVV and IVH will be respectively and simultaneously measured at the 
two emission arms. 
 
If the vertical polarisation direction is selected for the excitation channel and the second of the 3 options is 
selected for the emission channels IVV and IVH  will be measured at emission arm 1 subsequently, whereas a 
user defined polarised measurement will be made simultaneously in the second emission arm. 
If the vertical polarisation direction is selected for the excitation channel and the last of the 3 options is 
selected for the emission channels the spectrally resolved fluorescence intensities IVV  will be measured at 
both emission arms simultaneously and IVH will be measured for both arms afterwards. 
 
G Factor: The measurements for horizontal oriented polariser in the excitation channel are similar to the 
measurements described above. They are used to make the G factor correction.. 
 
All polarised measurements are stored automatically with the file extensions “.VV”, “.VH”, “.HV”, and “.HH”, 
dependent upon the orientation of the excitation and emission polarisers. 
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Pressing the Start button will commence the measurement and pressing the Cancel button will close the 
dialog box without performing any measurements. 
 
 
6.5.1 Sample Set Up Button 

Pressing this button will open the dialog box shown in Figure 6.17. 
 
There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 6.9(a) and it permits the user to select the measurement mode, based 
on the system geometry, for the measurement. 
 
Excitation: This tab is shown in Figure 6.17(b) and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Light Source radio group is used to select the source to be used in the experiment. 
 

d. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 
the Iris Setting dialog box. 

 
e. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-

hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 

Emission: This tab is shown in Figure 6.17(c) and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Detector radio group is used to select the detector to be used in the experiment. 
 

d. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 
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(b) 

 
 

(a) 
 
 
 
  

(c) 

Figure 6.17: Multiple measurement sample set up dialogs with (a) Mode tab, (b) Excitation tab and (c) 
Emission tab shown. 

 

 
6.5.2 Time Set Up Button 

Pressing the Time Set Up button opens either the dialog box shown in Figure 6.18 (for measurements made 
with the steady-state or nanosecond flashlamps) or Figure 6.19 (for measurements made with the 
microsecond flashlamp). 
 

 
(a) 

 
 
 
 
 

(b) 

Figure 6.18: Multiple measurement time set up dialogs for TCSPC mode measurements showing (a) Time 
Range tab and (b) Stop Condition tab.  

 

The settings for the Time Range  and Stop Condition tabs are: 
 

Time Range: This tab is used to set the timing conditions for the measurement. 
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a. Time Range: This is the overall duration of a single measurement and is selectable from the 
options in the drop-down box. The values range from 2.5 ns to 50 µs in sequences of (after the 
2.5 ns value) 1-2-5. 

 
b. Channels: This value is the number of channels to be measured over the time range. The 

available options are 512, 1024, 2048, 4096 channels. 
 

 
Stop condition: The tab is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 
 

a. Time: This setting stops the measurement after the specified time has elapsed.  
 

b. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
c. Manual: With this option the user has to stop the measurement manually by pressing the Stop 

button. This will override any entered values of Peak Counts, Time or External. 
 

d. External: This setting requires that an external interrupt signal is required to stop the 
measurement. This signal is applied to the control port of the TCC-900 card. 

 
 
Pressing the Options button will open the TCC-900 settings dialog box. This is described in Section 6.2. 
 
 
 

 

Figure 6.19: Multiple measurement time set up dialog box for 
MCS measurements. 

 
 
The items in the MCS Measurement dialog box are: 
 
Time Range: This is the overall duration of a single measurement and is selectable from the options in the 
drop-down box. The values range from 100 µs to 200 s in sequences of 1-2-4-8. 
 

Channels: This value is the number of channels to be measured over the time range. The available options 
are 500, 1000, 2000, and 4000 channels. 
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Lamp Trigger Delay: This value is the delay (in ms) of the lamp trigger with respect to trigger signal to the 
MCS card that commences an acquisition. It is used to adjust the  position the measured data on the data plot 
so that the data is clearly shown. The setting can be adjusted from 0.001 ms to 90.000 ms in steps of 0.001 
ms. 
 

Stop condition: The setting is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 

 
a. Sweeps:  This setting stops the measurement after the entered number of sweeps (single 

measurements) have been completed. Pressing the Apply button will display the time required 
for the entered number of sweeps to be performed. 

 
b. Time: This setting stops the measurement after the specified time has elapsed. Note that the 

entered time is adjusted by the software to ensure that an integral number of sweeps have been 
performed. Pressing the Apply button will perform this correction without starting the 
measurement. 

 
c. Peak Counts: The setting permits the user to stop the measurement once a specified number 

of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
 

6.6 Temperature Lifetime 
Temperature lifetime scans are used to examine the effect of temperature on temporal development of a 
fluorescence decay. The dialog boxes use for this purpose are shown in Figure 6.20. 
 

 

Figure 6.20: Dialog box for measuring temperature lifetime 
scans. 

 

The common constituents of these dialog boxes are: 
 
Sample: This radio group is use to select the sample position that is to be modified by pressing the Sample 
Set Up button. The options are only available if the multiple sample holder has been installed. 
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Instrument Response: Checking this box will indicate to the software that the measurement sequence is for 
an instrument response scan and the plotted data will be flagged accordingly. 
 
Scan From/To/Step: Enter the temperature range of interest in Kelvin (Scan from/to) and the number of 
degrees Kelvin between each measurement (Step). 
 
Accuracy Band: Enter the temperature tolerance range (in Kelvin) within which is the temperature is assumed 
to be stable. 
 
Stabilisation Time: Enter the time that the cryostat has to stay at each temperature before a measurement is 
acquired. 
 
Auto PID: The Proportional, Integral and Derivative settings can either be set manually on the cryostat 
controller or selected automatically from the learnt characteristics of the system by means of the Auto PID 
check box in the Temperature Scan Parameters. When the cryostat temperature is set to go to a higher 
temperature, the temperature increase has a hysteresis profile. This is one of the reasons for a stabilisation 
time. In order to minimise the hysteresis while maximising the speed of the temperature increase, the 
proportional, integral and derivative settings can be altered. We recommend that the temperature controller 
automatically sets these. More information on this can be found in the cryostat instruction manuals. 
 
 
Pressing the Start button will commence the measurement and pressing the Cancel button will close the 
dialog box without performing any measurements. 
 
 
6.6.1 Sample Set Up Button 

Pressing this button will open the dialog box shown in Figure 6.21. 
 
There are three instrumentation tabs, which are: 
 

Mode: This tab is shown in Figure 6.21(a) and it permits the user to select the measurement mode, 
based on the system geometry, for the measurement. 
 
Excitation: This tab is shown  in Figure 6.21(b) and it permits  the user to modify the instrumentation 
associated with the excitation monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Light Source radio group is used to select the source to be used in the experiment. 
 

d. If a computer-controlled iris is fitted, the opening of the iris (as a percentage) can be set using 
the Iris Setting dialog box. 

 
e. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-

hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 
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(b) 

 
 

(a) 
 
 
 
  

(c) 

Figure 6.21: Multiple measurement sample set up dialogs with (a) Mode tab, (b) Excitation tab and (c) 
Emission tab shown. 

 
 

Emission: This tab is shown in Figure 6.21(c) and it permits  the user to modify the instrumentation 
associated with the emission monochromator. The changes that can be made are: 

 
a. The monochromator wavelength can be changed in the Wavelength edit box by either entering 

a new wavelength directly into the box or by clicking on the increment arrows. The size of the 
increment is determined by the value of the Increment drop-down box. 

 
b. If fitted, the polariser setting can be changed by clicking the Angle drop-down box and choosing 

the desired angle from the options available. 
 

c. The Detector radio group is used to select the detector to be used in the experiment. 
 

d. If computer-controlled slits have been fitted then their separation is sown in the bottom, right-
hand corner of the tab, although the value cannot be changed here. This can only be done in 
the Signal Rate dialog box. 

 
 
6.6.2 Time Set Up Button 

Pressing the Time Set Up button opens either the dialog box shown in Figure 6.22 (for measurements made 
with the steady-state or nanosecond flashlamps) or Figure 6.23 (for measurements made with the 
microsecond flashlamp). 
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(a) 

 
 
 
 
 

(b) 

Figure 6.22: Multiple measurement time set up dialogs for TCSPC mode measurements showing (a) Time 
Range tab and (b) Stop Condition tab.  

 

The settings for the Time Range  and Stop Condition tabs are: 
 

Time Range: This tab is used to set the timing conditions for the measurement. 
 

a. Time Range: This is the overall duration of a single measurement and is selectable from the 
options in the drop-down box. The values range from 2.5 ns to 50 µs in sequences of (after the 
2.5 ns value) 1-2-5. 

 
b. Channels: This value is the number of channels to be measured over the time range. The 

available options are 512, 1024, 2048, 4096 channels. 
 

 
Stop condition: The tab is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 
 

a. Time: This setting stops the measurement after the specified time has elapsed.  
 

b. Peak Counts: The setting permits the user to stop the measurement once a specified number 
of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 

 
c. Manual: With this option the user has to stop the measurement manually by pressing the Stop 

button. This will override any entered values of Peak Counts, Time or External. 
 

d. External: This setting requires that an external interrupt signal is required to stop the 
measurement. This signal is applied to the control port of the TCC-900 card. 

 
 
Pressing the Options button will open the TCC-900 settings dialog box. This is described in Section 6.2. 
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Figure 6.23: Multiple measurement time set up dialog box for 
MCS measurements. 

 
 
The items in the MCS Measurement dialog box are: 
 
Time Range: This is the overall duration of a single measurement and is selectable from the options in the 
drop-down box. The values range from 100 µs to 200 s in sequences of 1-2-4-8. 
 

Channels: This value is the number of channels to be measured over the time range. The available options 
are 500, 1000, 2000, and 4000 channels. 
 

Lamp Trigger Delay: This value is the delay (in ms) of the lamp trigger with respect to trigger signal to the 
MCS card that commences an acquisition. It is used to adjust the  position the measured data on the data plot 
so that the data is clearly shown. The setting can be adjusted from 0.001 ms to 90.000 ms in steps of 0.001 
ms. 
 

Stop condition: The setting is used to determine the stop condition for the measurements. There are three 
possible ways of setting the stop condition and these are: 

 
a. Sweeps:  This setting stops the measurement after the entered number of sweeps (single 

measurements) have been completed. Pressing the Apply button will display the time required 
for the entered number of sweeps to be performed. 

 
b. Time: This setting stops the measurement after the specified time has elapsed. Note that the 

entered time is adjusted by the software to ensure that an integral number of sweeps have been 
performed. Pressing the Apply button will perform this correction without starting the 
measurement. 

 
c. Peak Counts: The setting permits the user to stop the measurement once a specified number 

of counts have been received on the (by default) highest amplitude channel of the data. If 
desired, the channel that the peak counts are measured can be specified by the user. 
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7 Viewing Data 
The View menu (described in the next chapter) offers options for displaying the data. This menu will only be 
available if data has previously been loaded from disk or if new data has been acquired. It is possible to view 
the acquired data in up to four different ways. These are: 
 

a. As 2D plot 
b. As 3D plot 
c. As Text plot 
d. As Contour plot 

 
 
The As 2D Plot and As Text options will always be available but As 3D Plot and As Contour Plot are only 
available if the active window contains a map (emission or absorption) measurement. 
 
The Plot Options depend on the type of plot currently active and are used to change the appearance of a plot. 
To display the plot options menu go to the View Menu and click in the “Plot Options menu”. You can also 
display this menu by clicking the Plot Options icon in the toolbar. 
 
 

7.1 As 2D plot 
 This is the default method and is also the only one that you can be used during data acquisition. It provides a 
two dimensional plot of the data being acquired. It also provides unique features such as a Cursor and Peak 
Searching. This 2D plot representation is also available by clicking the View as 2D Plot icon button. An 
example of a 2D plot is shown in Figure 7.1. 
 
 

 

Figure 7.1: Example of a 2-D plot (emission scan of Anthracene). 
 
 
 
Pressing the Plot Options menu item or toolbar button when a 2D plot is being displayed will open the dialog 
shown in Figure 7.2. 
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Figure 7.2: General 2D Plot menu 

 

The changes that can be made in this menu are: 
 
Font: Click the Change button inside the Font box. When the dialog box opens, select the font style and size 
as desired.  
 
Screen Colour Options: This submenu allows you to select the part of the plot you want to change in the item 
list (background, traces, axis ,etc). From the drop-down box select the item whose coulour is to be changed 
and then press the Change button to select a new colour. 
 
Line Style: Select a new line style from the options available. 
 
Line Width: Enter a new line width in the edit box, either directly, or by using the arrows at the side of the box. 
 
Miscellaneous Options: The Show Grid checkbox determines whether the plot should have a grid 
superimposed on it and the Show Cursor checkbox determines whether a cursor should be visible on the plot. 
 
To activate any changes, the Apply button should be pressed. After a change has been made, the user can 
select to make these changes as the default option for plotting. To do this, click the Save as Default button. 
For the case when no measurements are open and it is desired to set the defaults, it can be done in the same 
way by going into Plot Defaults in the Options menu. 
 
 
Depending on the 2D-plot type, the second tab in the Plot options menu will display a tab menu according to 
the plot type. Thus, there can be spectral, lifetime and fit tab menus. These are shown in Figure 7.3. 
 
In these tab menus, the user can select and modify the X and Y-scaling modes, and changes to the axis label. 
 
X-axis: For a spectral plot type, the only X-axis available is Wavelength. For a lifetime or fit type, it is possible 
to select Time or Channels as the Y-axis.  
 
Y-axis: In all the 2D-plot types, the Y-axis can be changed from linear to logarithmic, although the logarithmic 
scale may not be possible depending on the Y-range. The same effect as switching between linear and 
logarithmic Y-scale for an active window can be obtained by clicking the icons called “lin” and “log” in the 
toolbar. 
 
Scale from Zero: If this option is selected the Y-axis range will begin at zero. 
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7.2 As 3D plot 
This option allows a measurement containing several scans to be viewed in three dimensions.  The data can 
be viewed from various angles and heights to get a fuller picture of the measurement results. Any 
measurement can be viewed as a 3D plot as long as it has the properties of a map i.e. it contains more than 
one scan and all scans have equal step sizes. 
 
 

 

Figure 7.4: Example of a 3D representation of a map measurement. 
 
 
If the active window is a 3D plot, the plot options available can be summarised in the following list: 
 

a. Viewing Position 
b. Appearance 
c. Data 
d. Axes 
e. Printing 

 
 
Viewing position: This allows the user to select the angle (View From) and height (View Height) from which 
to view the data. The centre position provides an overhead view, where only the High viewing height is used. 
All viewing positions look towards the centre of the data. 
 

 
(a) (b) (c) 

Figure 7.3: Tab menus for (a) Lifetime 2-D plot , (b) Spectral 2-D plot, and (c) Fit 2-D plot. 
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Figure 7.5: Viewing Position tab. 
 
 
 

 
 
Appearance: In this menu the user can switch between perspective and orthogonal viewing modes. The Keep 
Aspect option is always on in Perspective mode. Here, you can also select the colours for each of the 
components of the plot (background, axes, etc) and the font type and size. To change the lighting, select 
Light1 or Light2 in the colours list. On the Colour dialog, select the colour you want for that light. To change 
the luminosity (or brightness) of the light, use the slider on the right hand side of the Colour dialog. Light 1 is 
positioned in line with the left axis wall, in front of the x-scale.  Light 2 is positioned in line with the back axis 
wall, to the right of the z-scale. 
 
 

 
(a) 

 

 
 

(b) 

Figure 7.6: Two views of a 3D plot. (a) View from front-right angle and middle height and (b) from front 
angle and middle height . 
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(a) 

 
(b) 

Figure 7.7: Appearance (a) and Data (b) tabs. 

 

 
Data: This tab menu permits the choice the surface style for the data. The options are a filled surface, mesh 
surface or dots.  
 
Axes: Tick the box labelled Filled Axis Panels for solid axis panels, clear it for lines. 
 
 

 
(a) 

 
(b) 

Figure 7.8: Axes (a) and Printing (b) tabs 
 
 
Printing: On the Printing tab, slide the pointer until the desired print resolution is displayed. The 3D plot will 
always appear the same size on the printed page regardless of this setting. Sliding the pointer fully to the right 
means that the 3D plot will be printed at the printer maximum resolution.  This results in the creation of a very 
large 3D-plot bitmap, which requires a lot of memory.  If this causes Windows to invoke virtual memory on 
disk, printing may take several minutes. Printing times may be reduced by decreasing the print resolution, 
using 256-colour mode instead of 24-bit true colour, or by adding more memory to the system.  The slider 
position second from the left is the default. 
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7.3 As Text 
Selecting this option displays the measurement data as a table of values and allows each of them to be edited 
individually if desired. A plot in text mode is shown on in Figure 7.9; the upper part displays measurement 
conditions, i.e. scan properties; while the lower part, a table, displays the measurement data. The data can be 
modified only in this mode. If it is wished to modify a datum value, click the corresponding cell in the table and 
type a new value. The plot options for Text mode are the same as those for 2D. 
 

 

 

Figure 7.9: Example of the text representation of a plot (emission scan of Anthracene). 

 
 
7.4 As Contour Plot 
 
Time resolved emission and transient absorption can be conveniently demonstrated as contour graphics as 
shown below. Like the 3D plot option, the Contour plot option is only available if the window contains more 
than one scan and all of them have equal step size (i.e. is a map).  
 
The contour graphics with inactive cursor and active cursor are distinctively different. If the cursor is not active 
the whole window contains only the contour plot. On the other hand, if the cursor is active, two other data 
displays are shown beside the main contour graphic: a view from the x-axes and a view from the y-axes (see 
figure below). The axes view show the data of the active cursor position. Data can be highlighted by pressing 
the Ctrl button and the left mouse button at the same time. Highlighted data can be removed by holding the 
Ctrl button and pressing the left mouse button at the point of the intersection of the cursor cross hair. 
 
The data in the axes windows can be normalised to the maximum by pressing the “N” button in the tool bar. 
 
When the zoom function is chosen no cross hair is shown initially. 
 
Additional contour lines can be added, contour lines can be removed, colours of contour lines can be changed, 
the resolution of the contour lines can be changed. Ref. to the contour plot options menu. 
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Figure 7.10: Example of a contour plot representation with active cursor (cross hair) and various marks 

 

Contour plots options: The Contour plot options windows permit the selection of the colour properties for the 
background, axis and grid. In this type of plot, each of the experimental data is defined as an individual line 
with its own properties. In this way, you can add and remove specific lines from the plot just by clicking Add or 
Remove and modify, individually, the line settings and line width of each of them. 
 
 

 

Figure 7.11: Contour plot options. 
 
 
Miscellaneous options 
 
Show cursor: This will enabled a Cursor in the window to read X and Y positions. 
 
Show Grid: This will create a window grid. 
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Normalise Cross Sections: As default, if this option is not ticked, the Y scale for the side windows on the 
bottom and right of the main contour window will have a constant interval, where the maximum Y value is 
defined by the biggest trace. On the other hand, if the “Normalise Cross Section” option is ticked, the Y scale 
range will be re-scaled to the maximum Y-value for each curve. The same effect is obtained if the normalised 
button on the toolbar is clicked: 
 
Resolution: Changes the resolution on the x-axes. This option is particular useful for decay data with large 
number of data channels. The editable value will define how many data points are averaged into one data 
point. 
 
Scale Data from zero: As in 2D plot options. 
 
Change Font: This will launch a “Font Dialog” box. 
 
Reset to defaults: This will load the last default settings saved. 
 
Save as defaults: This will save the current settings as default. 
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8 Data Analysis 
The data menu is designed for processing the data acquired with the LP920. This menu has some common 
options for all the data type and others that are specific for spectral and lifetime scans. The menu will be only 
enabled if a measurement window is opened or if data has been acquired. 
 
The general procedure is: 
 

 
 
The following sections describe how to use the common and specific data manipulation options. The subtitles 
will indicate whether the data option is applicable for spectral data only, for lifetime data only, or whether they 
are applicable for both. 
 
 

8.1 Combine (Lifetime and Spectral Data) 
This option adds, subtracts, multiplies or divides scans. 
 

1. Ensure the measurement window is in focus and contains only the scans that you want to work with. 
The operation will apply to all scans within the window so it may be necessary to extract a single 
scan. See next section about how to work with measurement windows. 

 
2. On the Data menu, select Combine, and then click the required function. 
 
3. On the list in the dialog box, select the scan to be added, subtracted, etc., from the list of all currently 

loaded scans. 
 
4. If the measurement is not a map, choose whether you want the resultant scan(s) to be added to the 

same window or placed in a new window.  
 
 
As an example, consider the addition of two traces called Sample1 and Sample2, where the measurement 
focus window is Sample2. 
 
To add both traces together, the user has to click in the Data menu/Combine/Add. A dialog box will launch as 
shown in Figure 8.1. 
 
The example in the dialogue box shows that Sample1 will be added to Sample2. The result can be shown in a 
new window Create new window or Add to existing window. 
 
 

Select the data window that contains the data by clicking in that window 

                                                     ↓ 
Select the mathematical operation to perform 

↓ 
Add the result in the same window or in a new one 
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Figure 8.1: “Add Data” dialogue box 
 
 
A further function for combining data in the Combine submenu not mentioned above is Append. This feature 
allows the user to combine 2 plots of overlapping wavelength ranges. The function can only be applied to 
append one file to another, therefore it is only present in the file menu when the active window contains only 
one spectral scan. This function is especially useful when a spectral scan has been obtained in multiple parts 
(i.e. due to the use of second order filters). To append data, make sure the lower wavelength range scan is the 
active window and click Data/Combine/Append, next highlight the scan you wish the plot to be appended to. 
If there is an overlap of spectral ranges, the user can choose the wavelength at which the data is appended, 
by writing the value in the Append at: box (by default the software will insert the midpoint of the overlap range 
in this box). There may be an scaling offset (i.e. due to variation in transparency of different second order 
filters), this can be allowed for by clicking the ‘Match amplitudes to’ tick box 
 
 

 
Figure 8.2: Append Data Dialog Box 

 

Figure 8.3 shows an example of how to append two plots with overlapping spectral ranges and a mismatch in 
amplitude. 
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Figure 8.3: Procedure for appending plots. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Two plots to be appended with 
overlapping spectral ranges 
and an amplitude mismatch. 

Extract the lower spectral 
range plot (sample 3) and 
make it the active window 

Open the Append data dialog Box: 
Data/Combine/Append 

Click on “Sample 4” to 
highlight it, tick the match 
amplitudes tick box and 
click Ok. The software has 
chosen a wavelength for 
the plots to be appended at 
(this can be altered if 
desired). 

Resultant Combined Spectra 
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8.2 Scale (Lifetime and Spectral Data) 
This option allows re-scaling the data by a factor. The user has to click the measurement window that is going 
to be re-scaled (to make it active) and then go in the Data/Combine/Scale menu. A dialog box (Figure 8.4) will 
be launched, where the user can type the factor for re-scaling. The result can be displayed in a new window or 
an existing one. 
 

 

Figure 8.4: Scale Data Dialog Box 
 
 
 

8.3 Normalise (Lifetime and Spectral Data) 
 

 

Figure 8.5: Normalise Data Dialog Box 
 

In order to normalise a scan(s), go to the option Normalise in the Data menu. This opens the Normalise Data 
to Peak Value dialog box (Figure 8.5). This option allows a value to be set for the highest peak in the spectral 
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scan, the rest of the scan is then scaled to fit. To do this type the value for the highest peak in the dialog box, 
set whether to add resultant plot to the current window or create a new window and click OK or Apply. In order 
to normalise the scan(s) to match the peak value of another scan, highlight it on the list in the dialog box, and 
its peak value will appear in the box. If you select a measurement container the maximum peak value from all 
its scans will appear, alternately, double-clicking on the measurement container folder will allow selection of a 
particular scan within the window. 
 
Figure 8.6 shows an example of how to make the highest peak of 2 different plots the same height. 
 
 

 
Figure 8.6: Procedure to Normalise Data. 

 

 
 

Data to be normalised has to be in 
the same active window. Then, click 
on Data/Combine/Normalised 
and the Dialog box will be launched 

Click on the folder relating to the 
active window. This inserts the 
largest peak (in this case from 
sample 2) as the normalised 
value Both traces in the active 
window will be normalised to the 
maximum value of sample 2 
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8.4 Subtract Baseline (Lifetime and Spectral Data) 
 
This option allows a baseline to be subtracted from a plot. This is especially useful when using detectors with a 
high dark counts (e.g. near-infrared photomultiplier tubes). Click on Data/Combine/subtract baseline and in 
the dialog box (Figure 8.7), type the Y value to be subtracted from each point on scan. The resultant plot can 
be shown in a new window or added to an existing window by clicking the relevant radio button and clicking 
Apply or OK.  
 

 
Figure 8.7: Subtract Baseline Dialog Box 

 

 

8.5 Crop Range (Lifetime and Spectral Data) 

 
Figure 8.8: Crop Data Range Dialog Box 

 

This option allows the user to crop the X-range data from the active measurement window. Click on the Data 
menu/Crop Range and set up the maximum and minimum limits in the dialog box (Figure 8.8). When the crop 
range dialog box is opened, the current viewable wavelength range is entered into the crop range boxes. 
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Therefore, a easy way to crop the range of a scan is to zoom into the area of the scan that you want, press 
Crop Range then click OK. The x-axis will then be cropped to that in the magnified area. 
 
 

8.6 Smooth (Spectral Data) 
It allows smoothing the data by applying a binomial approximation. To smooth a plot, open the Smooth dialog 
box (Figure 8.9), which is accessed through the submenu Data/Smooth. Select the number of adjacent points 
that you want to take into account when smoothing (3, 5, 7 or 9) and click OK. To smooth with a larger number 
of points repeat process, e.g. smoothing again with 3 points will effectively add another two to the previous 
number of points. 
 

 
Figure 8.9: Smooth Data Dialog Box 

 
 
The smoothing routine used by the software is effectively a weighted average. For smoothing by 3 points, the 
software multiplies each point by 2, adds adjacent points and divides by 4 (the outermost points are multiplied 
by 3, added to there adjacent point and divided by 4). Smoothing by 5 points repeats this twice, smoothing by 
7 points repeats it 3 times and smoothing by 9 points repeats it 4 times; This has the same effect as a 
weighted average of 5, 7 and 9 points. 
 
 

8.7 Differentiate (Spectral Data) 
This function calculates the derivative of n order of a active data scan. To perform a differentiation on a plot, 
open the Differentiate dialog box (Figure 8.10), which is accessed through the submenu Data/Differentiate. 
The function allows the user to differentiate from the 1st to the 9th order. If you want the scan(s) smoothed 
before differentiation, tick the Smooth First check box and select the number of points (see Smoothing, 
Section 8.6). 
 
Calculating the derivative of a spectral scan computes the rate of change of the counts with respect to the 
wavelength. Figure 8.11 shows an example of a differential of an emission scan. Calculating n derivative 
orders is analogous to carrying out the differentiation n times, for example, differentiating a spectral scan to the 
second order finds the rate of change of the rate of change of the counts with respect to the wavelength. 
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Figure 8.10: Differentiate Data Dialog Box 

 
 
 

 
Figure 8.11: Spectral Scan and its Derivative 

 

 

8.8 Integrate 
This function calculates the integral of an active data scan. To perform an integration on a plot, open the 
Integrate dialog box (Figure 8.12), which is accessed through the submenu Data/Integrate. 
An integral function is used to find the area under a curve, the software creates a plot of the integral function 
by making each point equal to the integral of the plot to the left of it. Therefore, in order to find the area under 
the whole plot, the cursor (see Section 9.3.6) has to be used to find the integral value of the last point.  Figure 
8.13 shows the integral function of a spectral scan. 
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   Figure 8.12: Integrate Data Dialog Box 
 

 

 
 

Figure 8.13 (a) Spectral scan, (b) Integral function 
    
 
 

8.9 Reverse 
This option performs the task of reversing the order of the data. It has the effect of producing a mirror image of 
the source data with the axis of symmetry being the midpoint of the data. The x-axis is not rescaled. This 
operation can be used to assist in comparisons of emission and absorption spectra. The dialog box used to 
carry out this operation is shown in Figure 8.14. 
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Figure 8.14: Reverse data edit box. 

 

 
 

8.10 Peak Search (Spectral Data) 
This option is designed to search for maxima and minima over a scan. To view the values of the peaks on a 
plot, click View/Peaks, or alternately click the icon on the toolbar:  
 
In order to configure the ‘show peaks’ option to find peaks of the correct height, the Peak Parameters dialog 
box has to be accessed (Figure 8.15) through the submenu Data/Peak Search Setup. 
 
The peak searching algorithm smoothes the data before searching for peaks and troughs. This technique 
helps to reduce the chance of noise values being wrongly detected as a peak feature. In the dialog box (Figure 
8.15), the Number of Points parameter defines the level of smoothing. Peak features in the smoothed data 
set are discriminated by the Shoulder Y Level. This level details the minimum intensity for a smoothed feature 
to be recognised as a peak or trough. Features below this value will be ignored. 
 
 

 

Figure 8.15: Peak Parameters Dialog Box 
 
Either (or both) peaks and troughs can be marked in the measurement window. The mark used is a vertical 
line with either the x-axis position or the number of counts (y-axis) of the feature. Figure 8.16 shows a scan 
with peaks shown on it. The parameters were setup with the dialog box shown in Figure 8.15. 
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The Sensitivity value defines the specific noise amplitude to be used for peak rejection. Any feature with 
relative amplitude less than this value will be considered as noise. Note that the relative amplitude of a feature 
is its height above a baseline between the base points of the feature. 
 
 

 
Figure 8.16: Scan Showing Peak Values 

 

 

8.11 Correction (Spectral Data) 
Once a spectral measurement has been acquired, if spectral correction was not carried out during acquisition, 
it can be corrected later on using the Correction option in the Data menu. Correction file measurements allow 
the spectral characteristics of the spectrometer to be measured so that scans can be adjusted to compensate 
for the transmission properties of the spectrometer at each step wavelength. 
 
When there is a spectral file to be corrected, clicking the Correction option opens the Manual Correction 
dialog box (Figure 8.17).  
 

 
Figure 8.17: Manual Correction Dialog Box 
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9 Windows-related Menus 
9.1 File Menu 
The file menu makes available typical Windows facilities to let you open and save files, as well as import, 
export and print them. Also, some other features that are specific to Edinburgh Instruments software, such as 
Properties, are included in this menu. 
 
 

 

Figure 9.1: File menu layout. 

 

New Spectral Measurement: The details of the measurements that can be performed with the F900 software 
are discussed fully in Chapter 5 (spectral) and Chapter 6 (lifetime). 
 
 
Open: Clicking this menu item launches the Open dialog box that allows the user to select the data file name 
and then open it. In the F900 software, the data files have extension .fl for kinetic traces and .fs for spectral 
files. The dialog box is also accessible by clicking File Open icon in the toolbar. 
 
 
Recent Files: This menu item allows the user to select one of the most recently opened files. 
 
Save: This menu item allows the user to store the contents of an active data window under the current 
filename. A window becomes the active window simply by clicking on it. The data can be saved in one of two 
formats: EI measurement format or Windows Metafile format. The latter one can be easily copied and pasted 
into another applications such as word processors. It is also possible to have access to this menu by clicking 
the Save icon in the toolbar. 
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Save As: This launches a Save As dialog box to save the contents of the active window as a file whose name 
is created by the user. As with the save option, the data can be saved in one of two formats: EI measurement 
format or Windows Metafile format.   
 
Close: This closes the active data window. The user will be prompted to save any unsaved data. 
 
Close All: This closes all the windows displayed, no matter whether they are active, inactive, or minimised. 
Before any of them close, there will be a prompt to save them. 
 
Properties: The scan properties are the set of measurement conditions of a measured scan. The F900 
software can display the properties information, present them to be edited, and also to export them to printer, 
file and clipboard. The Properties menu includes a full description of all the conditions used to collect the data 
(time window, time calibration, etc). Most of them can be edited by clicking in the Edit values box. To display 
the scan properties on the file menu, click properties or double click the Properties icon. 
 
Properties: The scan properties are a set of measurement conditions of a measured scan. F900 software can 
display the properties information (Figure 9.2), present them to be edited, and also to export them to printer, 
file and clipboard. The Properties menu includes a full description of all the conditions used to collect the data 
(time window, time calibration, etc) and most of them can be edited by clicking in the Edit values box.  To 
display the scan properties perform one of the following options: 
 

• On the File menu (or the right mouse click menu), click Properties. 
• Double click  the Properties icon. 

 
 
If the measurement container has more than one scan, the screen shows information relevant to the container, 
and allows you to select one scan from  Measurement List (see Figure 9.2). The properties of the scan are 
then displayed by pressing the Properties button, or by double clicking on the scan name in Measurement 
List. If only one scan is in the container, the scan properties' window is shown directly. 
 

 

Figure 9.2: Example of Container Properties box (fit container) 

 

The name of a scan, which has been selected from the measurement list, can be altered by typing. The 
alterations are shown 'live' on the graph. Pressing the Cancel button restores the original name(s). Scan 
properties can be edited at any time. The comment for the container file acts as the graph window's main title 
when the container is displayed. 
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Figure 9.3: Example of a scan properties page (spectral scan). 

 

 
 

 

Figure 9.4: Import ASCII dialog box 
 
The contents of the window can be transferred to the clipboard by pressing the To clipboard button and 
printed by pressing the Print button. If the contents of the scan have been edited, they are checked before any 
action is taken. When using these functions the date of printing is attached. The format of the date string is the 
"Short Date style" specified on the Date tab of the Regional Settings icon in the Windows Control Panel. 
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Figure 9.5: ASCII format export dialog box 
 
 
Import GEM: This option allows you to import data obtained with previous versions of the F900 software 
running under GEM operating system format (GEM is the data format that was used in spectrometers prior to 
1995) into the F900 Windows version.  The same effect is obtained by clicking the Import Gem icon.  
 
 
 

            Labels Anthrascene Emission  
            Type Emission Scan  
            Comment   
            start(nm) 365.00  
            stop(nm) 500.00  
            step(nm) 1.00  
            fixed/offset(nm) 357.00  
            Xaxis Wavelength  
            Yaxis Counts  
            365.00 1.800E+3  
            366.00 2.806E+3  
            367.00 4.464E+3  
            368.00 7.520E+3  
            369.00 1.371E+4  
            370.00 2.214E+4  
            371.00 3.030E+4  
            372.00 4.269E+4  
            373.00 7.198E+4  
            374.00 1.335E+5 

Figure 9.6: Section of data exported in ASCII format by 
F900 software 

 

Import ASCII: This option allows the user to load data in ASCII format and perform a conversion into EI data 
format. Every time that a data file is open or imported from ASCII or GEM into L900, the software identifies if 
the data are kinetic traces, spectral scans or time-resolved data and creates a specific container according to 
this. A series of check boxes on the dialog menu (Figure 9.4) allows the user to choose the type of delimiter 
and which columns contain the data for each axis. This option can also be accessed by pressing the Import 
ASCII toolbar button. 
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Export ASCII: This option allows the data to be exported in ASCII format and subsequent importing of the 
data into other applications (such as spreadsheets) that use the ASCII format. When the Export ASCII option 
is selected in the File menu or when the Export ASCII icon is clicked, the system launches a Data export 
format box (Figure 9.5). A pair of radio buttons permit the user to choose whether the data is to be saved in 
rows or columns. In addition, a set of radio buttons allow the user to choose a character that will serve as a 
separator between the numeric values in the raw data. The importing application can then be configured to 
recognise this separator (or delimiter) and, in the case of a spreadsheet, display the data in a suitable 
configuration of rows and columns. The properties can also be included in the exported file of the 
measurement by clicking in the Include properties box. These properties will be located at the beginning of 
the ASCII file. An example of the exported data is shown in Figure 9.6. 

 
Print setup: This launches a standard Print Setup window. 
 
Print: This launches a Print Dialog Box as shown in the picture below. The user can select the colours to be 
used by the printer to plot the data (Printer Colour Options) or select to print it as it is shown in the screen (Use 
Screen Colours).  
 
The print option is also accessible by clicking the Print icon. 
 

 

Figure 9.7: Print dialog box 
  
 
Exit: This closes the F900 software. The user will be prompted to save all the data unsaved. 
 
 

9.2 Edit Menu 
The only option available in the Edit menu is a Copy (Ctrl-C) facility that allows copying of the active window, 
and (Ctrl-V) to paste it in another program. 
 
 
 
 
 
 

9.3 View Menu 
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When the View Menu is selected, the drop-down box shown in Figure 
9.8 is displayed. The various items in this menu will now be described. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9.3.1 Lamp setup 

This menu item is used to setup the lamps installed with the system. Depending on the configuration, either or 
both of the microsecond flashlamp and the nanosecond flashlamp may be available. 
 
 

 

Figure 9.9: Dialog box to set up the microsecond flashlamp. 

 

The dialog box used to set up the microsecond flashlamp is shown in Figure 9.9. The only option that can be 
set here is the lamp frequency. This has a resolution of 0.1 Hz and can be set in the range 0.1 – 100.0 Hz. 
 
 
The dialog box for the nanosecond flashlamp is shown in Figure 9.10. The settings that can be made here are 
closely interrelated and reference should be made to the “nF 900 Nanosecond Flashlamp” operating 
instructions manual  for compatible values of EHT, Frequency, Gas and Gap. Pressing Switch Lamp On will 
start the lamp and the parameters in the Measured Parameters grouping will be activated. The Auto Start 
check box is used to indicated whether the nanosecond flashlamp should start as soon as a measurement 
sequence is commenced. 
 
 

 

Figure 9.8: View menu options. 
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Figure 9.10: Dialog box for setting up the nanosecond flashlamp. 
 
 
9.3.2 Signal Rate 

Selecting this menu item opens the Signal Rate dialog box that is described in Section 5.1. 
 
9.3.3 As 2D Plot, As Contour, As 3D Plot, As Text 

These options are used to set how the data is viewed and they are controlled by a radio button so that only 
one of them is valid at any particular time. The As Contour and As 3D Plot options are only available for map 
measurements. Further details of these settings are provided in Chapter 7. The currently selected plot style is 
indicated by a black dot next to it. 
 
9.3.4 Plot options 

Selection of this menu item open the Plot Options dialog box that is used to control how the data is 
presented. Further detail of plot options are described in Chapter 7. 
 
9.3.5 Zoom In 

Selecting this menu item places a cross-hair cursor on the plot. Dragging this cross-hair will produce a 
rectangle and when the mouse button is released the plot will zoom-in to the area delineated by this rectangle. 
Once a plot has been zoomed, a Zoom Out menu item will also appear. Selecting this menu item will restore 
the plot to its original scaling. If a plot is already zoomed the nan arrow is displayed next to the menu item. 
 
9.3.6 Cursor 

Selecting this option will place a vertical cursor on the plot. Moving this cursor with the mouse will cause the 
co-ordinates of the data point beneath the cursor to be displayed. The x-ordinate is displayed at the bottom left 
of the plot and the y-ordinate(s) is/are displayed on the right hand side of the plot. The menu item has a tick 
mark next to it if the cursor is visible. 
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9.3.7 Grid 

Selecting this option will superimpose a grid on the plot. The presence of a grid is denoted by a tick mark next 
to the menu item. 
 
9.3.8 Peaks 

Selection of this item will display the amplitudes of the peaks that  are present in the plot. The criteria for peak 
selection are made with the Peak Search Set Up menu item described in Section 8.10. 
 
 
9.3.9 Normalise 

This option is used with contour plots to normalise the data to the selected data value. The use of this option is 
indicated by a tick mark next to the menu item. 
 
 
9.3.10 Status bar 

Selecting this option will display the status bar that shows the current settings for the spectrometer hardware 
and also messages that have been reported by the system. This visibility of the status bar is indicated by a tick 
mark next to the menu item. 
 
 
9.3.11 Tool bar 

Selecting this option will display the toolbar containing the Edinburgh Instruments speed buttons. The visibility 
of the toolbar is denoted by a tick mark next to the menu item. 
 
 

9.4 Options Menu 
When the Options Menu is selected then the drop-down menu 
shown in Figure 9.11. These options will now be discussed in 
more detail. 
 
 
 
 
 
 
 
 
 
 
9.4.1 Plot defaults 

This menu item opens a dialog box containing the plot settings for all the measurement types available for the 
F900 software. Further details of plot settings are provided in Chapter 7. 
 
 
9.4.2 Correction files 

If it is intended to correct captured data for the effects of instrumentation then correction files have to be used. 
To inform the system of the files to be used, click Correction Files. The dialog box shown in Figure 9.12 will 
then be displayed. 
 

 

Figure 9.11: Options menu items. 
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Figure 9.12: Correction files selection dialog box. 

 

This dialog box permits correction files to be entered for the Reference Detector, the Excitation 
monochromator and one or more Emission monochromators. The tab for the Reference detector is shown in  
Figure 9.12, but the other two tabs are identical. To enter a file name press the Modify button. This will open a 
Windows File Open dialog box. Navigate to the correct directory and file and then press Open. This will place 
the file name in the Reference Detector File edit box. If no correction file is to be applied to a measurement 
then the Reference Detector File edit box should be cleared. 
 
 
9.4.3 Windows options 

The Windows Options dialog box is used to select the methods of handling the plot windows. It is accessed 
by pressing the Windows Options item in the Options menu. 
 
 

 

Figure 9.13: Dialog box for windows options. 
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The Items that can be checked are: 
 
Join multiple files on open: If this option is selected then when multiple files are selected with the Open 
menu (Section 9.1) they will, if possible, be loaded into a single plot. Otherwise they will be loaded into 
individual plots. Files can only be loaded in to one plot if the are the same measurement type. 
 
Append filenames to scans on combining: If this option is selected then previously saved files will have 
their filename appended to their scan name when they are involved in combine operations. 
 
Close source window on split: If this option has been selected then the source window for the waveforms 
will be closed when a split operation is performed, so that only the newly created windows will be displayed. 
 
Close source window on extract: If this option has been selected then the source window for the waveforms 
will be closed when an extract operation is performed, so that only the newly created windows will be 
displayed. 
 
Close source windows on join visible: If this option has been selected then the source window for the 
waveforms will be closed when a join visible operation is performed, so that only the newly created windows 
will be displayed. 
 
Autocorrect old files on open: 
 
 
The other items in this dialog box are: 
 
Recently used file list: The number of files to be explicitly displayed in the File drop-down menu. 
 
Temperature Tolerance: When separate files are combined, checks are performed to see whether the 
combined files constitute a map measurement. One of the checks is on whether the temperatures are the 
same. This check compares exact temperature values so a small difference will prevent a map being 
established. Entering a non-zero value in this edit box will make the comparison process examine whether 
there is an overlap in the temperatures when the tolerance value is taken into account. If so, then a map will be 
allowed. 
 
 
 
9.4.4 Hardware configuration 

This menu item opens the Hardware Configuration dialog box that is described in Chapter 3. 
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9.4.5 PCS900 configuration 

 

Figure 9.14: PCS900 configuration dialog box. 

 

Selecting the PCS900 Configuration option will open the dialog box shown in Figure 9.14. This box permits 
changes to be made to the DAC (Digital to Analogue Converter) thresholds on each of the card channels. In 
addition, software and hardware version information is supplied for the user. 
 
 
 
9.4.6 Drivers and cards 

Selecting this option will open an ‘information-only’ dialog box, shown in Figure 9.15 . The information 
contained in the box will show the presence of the DLLs used to interface to particular hardware component 
and also the presence of the hardware component. 
 

 

Figure 9.15: Summary of the presence of hardware options and of the 
software utilities used to interface to them. 

 
 
 
 

9.5 Window Menu 
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The window menu is divided in three parts: the first one is a general feature to all Windows environments and 
includes options to display the windows vertically, horizontally or in cascade. 
 

Tile Vertically: to fit all open windows into the client area with their heights maximised. 
 
Tile Horizontally: to fit all open windows into the client area with their widths maximised. 
 
Cascade: to overlap all open windows with their title remaining visible. 
 
Arrange Icons: to arrange all minimised windows so that their icons don’t overlap. 

 
When tiling or cascading make sure all the windows to be displayed are open. Minimised windows cannot be 
displayed. 
 
 
The second part of the Window menu is specific for the F900 software and includes options to display and 
work with data windows.  
 
Note: Every time that the user wants to do some operation with a data window, it is first necessary to set up 
the focus of input in that window. To do this, perform one of the following two procedures: 
 

• select the  name of the window to be made active in the list.  
 
• left click the mouse on any part of the window.  

 
 
The operations that can be performed on the data windows are: 
 

Extract: This operation extracts one or more scans from a window that contains more than one scan. To 
perform the operation follow these steps: in the Window menu, click Extract and select the scans to be 
extracted from the measurement list. Alternatively, right click in the active Window and select Extract. A 
further alternative for running this operation is to press the Extract toolbar button. 
 
 
Split: The Split function splits a window with more then one data set into individual scans. To perform 
the operation go to the Window menu and click Split. Each scan in the source container will be 
displayed in its own window. Alternatively, right click in the active Window and select Split. A further 
alternative for running this operation is to press the Split toolbar button. 
 
 
Join Visible: This option joins separate data windows into a single one, provided the data are of the 
same type, e.g. windows containing spectral data and other windows containing kinetic data can not be 
joined together. The function does not have any effect on minimised data windows. On the Window 
menu click Join. Compatible scans in all the open windows will be merged into a new window. An 
alternative for running this operation is to press the Join Visible toolbar button. 
 
Insert scan: This option allows the addition of a scan into a data window. After selecting this function a 
list of all windows and the individual data within those windows is provided. From this, the scans to be 
inserted can be chosen. To perform this operation, select Insert scans from within the Window menu. 
This function is also available by right clicking in the window and selecting Insert scans. 
 
Delete Scan: This option permits the deletion of a specific scan from a data window. Deleted data will 
not be retrievable. To perform the operation, click Delete scans in the Window menu. Alternatively, right 
click in the Window and select Delete scans. 
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Figure 9.16: Graphical demonstration of some important Window manipulating functions. 

 
 
Additional comments about working with data windows. 
 
During the operation of fluorescence spectrometers, many data sets will be created, and manipulation of these 
data sets can generate a large number of data windows. In order not to get lost among the many data windows 
it is advisable to minimise as many data windows as possible and to title the windows appropriately. 
 
 
 

9.6 Help Menu 
The help menu contains two items, which are 
 
Help Topics: Pressing this menu item opens a “windows style” help dialog box containing information that is 
designed to assist the user in using the F900 software. 
 
About F900: This dialog box displays version information regarding the currently installed F900 software. 
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10 Warranty 

1  a) The Company guarantees the equipment forming the subject of the contract/quotation against defective 
materials and workmanship for a period of one year from the date of delivery to the Purchaser. 

b) In the case of sub-assemblies of equipment not manufactured by the Company, but incorporated in the 
equipment ordered, the Purchaser will be entitled only to the benefit and/or limitations of any guarantee 
given by the makers of such assemblies. 

c) In no event shall the Company be liable for any consequential loss or damage arising from failure of the 
equipment under warranty. 

d) At the end of the one year period referred to herein, all claims upon all liability of the Company shall be 
absolutely at an end. 

 
2  a) The Company also warrants that the equipment conforms to specifications confirmed in writing at the 

time of order acknowledgement. 
b) No warranty is made or implied as to the suitability of any equipment for the Purchaser’s intended use 

beyond such performance specifications as form part of the contract.  
 
3. The purchaser warrants: 

a) That he will carefully examine and list all parts of the equipment supplied by the Company and notify the 
Company in writing of any shortage, defect or failure to comply with the contract, which is or ought to be 
apparent upon such examination and test, within 48 hours of the equipment being delivered to or 
collected by the Purchaser. 

b) The equipment will be operated in accordance with the instructions and advice detailed in the 
appropriate operating instructions manual, or any other instructions which may be provided by the 
Company.  The Company shall not be held responsible for any defect arising from the Purchaser’s 
failure to comply  with these recommendations and instructions or from damage arising from negligence 
or exposure to adverse environmental conditions. 

 
4. The warranty is effective when: 

a) Any defects in the equipment supplied are notified immediately by the Purchaser to the Company. 
b) The equipment is returned to the Company at its Edinburgh premises, transportation and insurance 

prepaid, and undamaged by the failure to provide sufficient packaging. 
c) The Purchaser has made payment in full for the contract in accordance with the Company’s normal 

trading terms, i.e. 30 days from date of invoice. 
 
5. The warranty covers: 

a) Engineer’s time costs during inspection and repair. 
b) Any materials or components, which require to be replaced. 
c) Return carriage costs to the Purchaser 

 
6. However, if the Purchaser requests a service engineer to carry out the necessary inspection and repair of 

the equipment covered by the warranty on site, the Purchaser will be liable, at the Company’s discretion, for: 
a) Engineer’s travelling time costs. 
b) Engineer’s travelling and accommodation expenses. 

 
The timing of the inspection and repair of the equipment will be determined entirely at the discretion of the 
Company. 
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11 CE Declaration of Conformity 

       
 
 
 
Manufactured by:    Edinburgh Instruments Ltd. 
     2 Bain Square 
     Livingston 
     EH54 7DQ 
     Tel.: + 44 1506 425 300 
     Fax.: + 44 1506 425 320 
 
 
Applicable Standards:   Generic Immunity   EN 50082-1 : 1992 
     Generic Emission   EN 50081-1 : 1992 
     Electrical Safety Standards  EN 61010-1 : 1993 
 
 
 
Edinburgh Instruments Ltd. certify that this equipment conforms to the protection requirements of the 
above Directives. 
 
 
 


